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New Features

This revision adds installation and configuration instructions for the Red Hat
®

Enterprise Linux
®

(RHEL) 7.1 operating system and the SLES
®

12 operating system.

Information about SGI Foundation Software tools, such as the hardware event tracker
and CPU frequency scaling, has moved to the following manual:

SGI Foundation Software (SFS) User Guide
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About This Guide

SGI installs operating system software and the SGI Foundation software on all SGI
UV

TM

300, SGI UV 2000, SGI UV 1000, and SGI UV 100 systems before the systems
leave the factory. The operating system software is either Red Hat

®
Enterprise Linux

®

(RHEL) or SLES
®
. In the event of a disaster or system failure, you can use the

instructions in this manual to reinstall this software.

This guide does not support the following SGI UV systems:

• SGI UV 20 systems or SGI UV 10 systems.

• SGI
®

UV
TM

for SAP HANA
®

appliances. If you have an SGI UV for SAP HANA
appliance, do not attempt the procedures in this manual. Please contact technical
support if you need assistance with operating system procedures.

Related Publications
The SGI Foundation Software release notes and the SGI Performance Suite release
notes contain information about the specific software packages provided in those
products. The release notes also list SGI publications that provide information about
the products. The release notes are available in the following locations:

• Online at Supportfolio. After you log into Supportfolio, you can access the release
notes. The SGI Foundation Software release notes are posted to the following
website:

https://support.sgi.com/content_request/194480/index.html

The SGI Performance Suite release notes are posted to the following website:

https://support.sgi.com/content_request/786853/index.html

Note: You must sign into Supportfolio, at https://support.sgi.com/login, in order
for the preceding links to work.

• On the product media. The release notes reside in a text file in the /docs directory
on the product media. For example, /docs/SGI-MPI-1.x-readme.txt.
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About This Guide

• On the system. After installation, the release notes and other product
documentation reside in the /usr/share/doc/packages/product directory.

The following additional documentation might be useful to you:

• SGI Foundation Software (SFS) User Guide, publication 007–6410–xxx.

Describes how to use the tools and utilities in SFS.

• SGI UV RMC Software User Guide, publication 007–6361–xxx.

Describes how to use the rack management controller (RMC) to monitor and
manage SGI UV 300 systems.

• SGI UV System Management Node Administrator Guide, publication 007–5694–xxx

Describes how to install, configure, and administer the system management node
(SMN) on SGI UV 2000, SGI UV 1000, and SGI UV 100 series systems.

• SGI UV CMC Software User Guide, publication 007–5636–xxx

Describes how to use the chassis management controller (CMC) to monitor and
manage SGI UV 2000, SGI UV 1000, and SGI UV 100 systems.

The SGI Knowledgebase includes additional technical information. For example, the
Knowledgebase includes a document that explains how to boot an SGI UV 1000
system using the iSCSI protocol and how to boot from a Fibre Channel Disk. Contact
your SGI representative for this information.

SGI creates hardware manuals that are specific to each product line. The hardware
documentation typically includes a system architecture overview and describes the
major components. It also provides the standard procedures for powering on and
powering off the system, basic troubleshooting information, and important safety and
regulatory specifications.

The following procedure explains how to retrieve a list of hardware manuals for your
system.

Procedure 0-1 To retrieve hardware documentation

1. Type the following URL into the address bar of your browser:

docs.sgi.com

2. In the search box on the Techpubs Library, narrow your search as follows:

• In the search field, type the model of your SGI system.
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For example, type one of the following: "UV 300", "ICE X", Rackable.

Remember to enclose hardware model names in quotation marks (" ") if the
hardware model name includes a space character.

• Check Search only titles.

• Check Show only 1 hit/book.

• Click search.

Obtaining Publications
You can obtain SGI documentation in the following ways:

• You can access the SGI Technical Publications Library at the following website:

http://docs.sgi.com

Various formats are available. This library contains the most recent and most
comprehensive set of online books, release notes, man pages, and other
information.

• You can view man pages by typing man title at a command line.

Conventions
The following conventions are used throughout this document:

Convention Meaning

command This fixed-space font denotes literal items such as
commands, files, routines, path names, signals,
messages, and programming language structures.

variable Italic typeface denotes variable entries and words or
concepts being defined.

user input This bold, fixed-space font denotes literal items that the
user enters in interactive sessions. (Output is shown in
nonbold, fixed-space font.)
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[ ] Brackets enclose optional portions of a command or
directive line.

... Ellipses indicate that a preceding element can be
repeated.

manpage(x) Man page section identifiers appear in parentheses after
man page names.

GUI This font denotes the names of graphical user interface
(GUI) elements such as windows, screens, dialog boxes,
menus, toolbars, icons, buttons, boxes, fields, and lists.

Reader Comments
If you have comments about the technical accuracy, content, or organization of this
publication, contact SGI. Be sure to include the title and document number of the
publication with your comments. (Online, the document number is located in the
front matter of the publication. In printed publications, the document number is
located at the bottom of each page.)

You can contact SGI in either of the following ways:

• Send e-mail to the following address:

techpubs@sgi.com

• Contact your customer service representative and ask that an incident be filed in
the SGI incident tracking system:

http://www.sgi.com/support/supportcenters.html

SGI values your comments and will respond to them promptly.
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Chapter 1

Introduction

This chapter contains the following topics

• "About Installing the Operating System Software, SGI Foundation Suite, and
Optional Features" on page 1

• "About Partitioned SGI UV Systems" on page 2

• "About Installing the SGI Performance Suite" on page 3

About Installing the Operating System Software, SGI Foundation Suite, and
Optional Features

This manual explains how to install the operating system software and SGI
Foundation Software (SFS). You can reinstall this software to meet site requirements
or you can reinstall in the event of a disaster or a system failure. SGI supports the
following operating systems:

• SGI supports Red Hat Enterprise Linux (RHEL) 7.1 and SLES 12 on SGI UV
servers.

• SGI supports RHEL 6.6 and SLES 11 SP3 on SGI UV servers and on SMNs.

After your SGI UV is configured with the operating system software and SFS, you can
configure SFS according to your site’s needs. For information about SFS components
and features, see the following:

SGI Foundation Software (SFS) User Guide

Note: SGI recommends that you install new SFS packages as they become available.
This pertains to SGI UV servers and to SMNs. Even if your SMNs are installed with
the most recent, supported operating system distribution software available and you
are no longer upgrading the operating systems, SGI still recommends that you install
the latest versions of SFS on your SMNs.

The procedures in this guide were developed using the following hardware and
software:
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1: Introduction

• An SGI UV 300 system. This system was the primary test system for this revision.
The SGI UV 300 system includes a rack management controller (RMC). The SGI
UV 300 system does not include a system management node (SMN). SGI tested
the RHEL 7.1, RHEL 6.6, SLES 12, and SLES 11 SP3 installation procedures on this
hardware platform.

• An SGI UV 2000 system with an SMN. This secondary test system represents all
systems that typically include an SMN. Differences for other SGI UV system
models are noted in the text, but noted differences are not comprehensive.
Differences are noted for systems without an SMN.

SGI tested the RHEL 7.1, RHEL 6.6, SLES 11 SP3, and SLES 12 installation
procedures on this hardware platform for previous revisions of this manual and
did not retest these procedures for the current manual revision.

• As noted, the RHEL 7.1, RHEL 6.6, SLES 12, and SLES 11 SP3 operating systems
were used during this documentation’s development. Different operating system
levels might behave somewhat differently on SGI hardware.

• The SGI Foundation Software 2.12 release. SGI requires that the SGI Foundation
Software be installed on each SGI UV system. You can install the SGI Foundation
Software on the SGI UV server and on the SMN after you install the operating
system software.

• The System Management Node 1.11 release. If your SGI UV system includes a
SMN, install the SMN software on this node.

About Partitioned SGI UV Systems
You can use the installation instructions in this manual to install RHEL or SLES as a
single-system image on an entire SGI UV system. Alternatively, if your SGI UV
system is divided into partitions, you can use these instructions to install RHEL or
SLES on an individual partition. The installation procedure, including the disk
partitioning instructions, is identical for both purposes. For information about
partitioning, see the following:

SGI Foundation Software (SFS) User Guide
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About Installing the SGI Performance Suite
The SGI Performance Suite is an optional package, but you need to install the SGI
Performance Suite if you want to partition your SGI UV system or if you want to use
superpages.

The SGI Performance Suite is also required if you want to use any of the following
software:

• SGI Accelerate, which includes optimized software libraries and run-time
performance tools.

• SGI MPI, which is SGI’s high-performance message passing interface environment.

• SGI REACT, which is SGI’s hard real-time performance solution.

For information about how to install the SGI Performance Suite software, see the SGI
Performance Suite release notes. The release notes reside in a text file in the /docs
directory on the product media. After installation, the release notes and other product
documentation reside in the /usr/share/doc/packages/product directory.
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Chapter 2

Installing the SGI UV System Software

This chapter includes the following topics:

• "About Installing SGI UV System Software" on page 5

• "Gathering Installation Materials and Information" on page 7

• "(Optional) Setting or Changing an Administrative Password on the Console" on
page 15

• "(Conditional) Installing the System Software on the SMN" on page 21

• "Installing the System Software on the Server" on page 22

About Installing SGI UV System Software
SGI installs operating system software, the SGI Foundation Software (SFS), and any
additional customer-purchased software on all SGI UV systems before the systems
leave the SGI manufacturing facility. The operating system can be one of the
following:

• Red Hat Enterprise Linux (RHEL)

• SLES

If your site practices require you to reinstall the software, or if a disaster occurs at
your site, you can use the procedures in this manual to reinstall all the
factory-installed software. The procedures in this manual assume the following:

• You, the installer, are familiar with Linux operating systems, and you are familiar
with the operating system software update process. The installation instructions
describe how to register the operating system installation with the operating
system software provider to ensure automatic updates. This manual assumes that
your site wants to use the automatic updates. As an alternative, you can use
physical media to apply updates.

• You want to reinstall the factory-installed software on the SGI UV server and, if
present, on the SGI UV system management node (SMN). The SGI UV 300 does
not include an SMN. The SGI UV 2000, SGI UV 1000, and other SGI UV models
can include an SMN.
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2: Installing the SGI UV System Software

• Your SGI UV system is cabled correctly and attached to the network in accordance
with your site practices.

There is a specific order in which you need to install software on an SGI UV system.
This order is as follows:

1. Install the system software on the SMN, if present.

To install the software on an SGI UV SMN, install the software in this order:

a. Operating system software, either RHEL 6 or SLES 11. SGI does not support
RHEL 7 or SLES 12 on SMNs.

b. SGI Foundation Software

c. SGI SMN Software

2. Install the system software on the SGI UV server.

To install the software on an SGI UV server, install the software in this order:

a. Operating system software, which can be RHEL 7, RHEL 6, SLES 12, or SLES
11.

b. SGI Foundation Software

c. (Optional) SGI Performance Suite software. This optional SGI product is
required if you want to partition your SGI UV system.

If you need to install the system software on both an SGI UV server and on an SGI
UV SMN, install the software on the SMN first. In other words, after you install the
operating system software, the SGI Foundation Software, and the SMN software on
the SMN, then you can install the system software on the SGI UV server.

The operating system installation procedure is nearly identical for both the SGI UV
server and the SMN. Use the operating system installation procedures in this manual
as a guide when you perform the operating system installations on both the SGI UV
server and the SMN. Small differences related to the platforms are noted within the
procedures.
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Gathering Installation Materials and Information
The following procedure explains how to gather the information you need for the SGI
UV server operating system installation session. If you gather the information you
need in advance, you can complete the installation more quickly.

Procedure 2-1 To gather installation materials and information

1. Verify your environment.

Depending on your hardware, you might need additional equipment or specific
network connections, as follows:

• For SGI UV 300 computer systems, make sure that your computing
environment provides the following:

– Physical access to the SGI UV 300 server. You need to insert disks into the
DVD drive that is installed on the server.

– A workstation or computer that has access to the rack management
controller (RMC).

• For SGI UV 2000, SGI UV 1000, and SGI UV 100 computer systems with an
SMN, this documentation assumes that the SMN is a factory-installed SMN,
which includes Java software. If your SMN hosts a custom installation, the
procedures in this manual might fail. In addition, this documentation assumes
that you can insert DVDs into the DVD drive on the SMN.

• For SGI UV 2000, SGI UV 1000, and SGI UV 100 computer systems without an
SMN, plan to attach a keyboard, monitor, and mouse directly to the Base I/O
BMC on the SGI UV server. If you plan to install onto an SGI UV 2000 system,
and you need this equipment, plan to procure an approved USB DVD drive
from SGI. Contact your SGI representative and ask for the USB DVD drive
with marketing code LSV-DVD-EXT.

2. Locate the software DVDs or CDs that SGI sent to you, or download and create
DVDs or CDs.

This manual assumes that you have DVDs of the operating system and CDs of
the SGI software.

You can obtain the operating system software in one of the following ways:

• In a media kit from SGI. SGI distributes DVD copies of the RHEL and SLES
operating system releases.
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2: Installing the SGI UV System Software

• As a software download. You can download the RHEL and SLES releases
from the Red Hat or SUSE websites and write the software to a DVD.

You can obtain the SGI software from the SGI Supportfolio website. To download
the SGI software, complete the following steps:

• In a browser window, navigate to the following URL:

https://support.sgi.com/login

SupportFolio prompts you for your username and password.

• Download the SGI software that you need. If you install the operating system
software, also plan to install the SGI Foundation Software.

• Write the ISO file to a CD or DVD. The instructions in this manual assume
that you have hard media. Some procedures explain how to access the release
software if you want to install from a network-resident ISO image, but the
instructions are not comprehensive. If you wrote downloaded ISO images to
your house network and you do not want to write them to hard media, plan
to use your network tools to access the software when the procedures instruct
you to insert a DVD or CD.

3. Plan the order in which to install the software.

If you need to install both the SGI UV server software and the SGI SMN software,
plan to install the SMN software first. You can install the SGI UV server software
after the SMN software installation is complete.

4. Gather the information that the installer requires.

The installation requires you to provide information about passwords, your
public (or house) network, and so on. You can complete the installation more
quickly if you gather this information before you begin. Obtain the system
configuration information that was used when the SGI UV System was originally
configured. The following list shows the information you need to collect:

• SGI UV server fully qualified domain name (FQDN)
__________________________________

• SGI UV server hostname __________________________________

• SGI UV server IP address __________________________________

• SGI UV server subnet mask __________________________________
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• Site DNS server IP addresses __________________________________

• Site search domain __________________________________

• Password for the SGI UV server’s system administrator (root user) login
__________________________________

• FQDN of your site’s network time protocol (NTP) server
__________________________________

• IP address of your primary name server __________________________________

• IP address of your secondary name server
__________________________________

• Fully Qualified Domain Name (FQDN) of the following:

– On SGI UV 300 systems, obtain the FQDN of the rack management
controller (RMC).

– On SGI UV 2000, SGI UV 1000, or SGI UV 100 systems without an SMN,
obtain the FQDN of the chassis management controller (CMC).

On SGI UV 2000, SGI UV 1000, or SGI UV 100 systems with an SMN, you
do not need to obtain the FQDN of the CMC.

• For RHEL installations, do the following:

– Verify your site’s Red Hat Networks (RHN) registration status and your
Customer Center registration status.

– Obtain your RHN login.

– Obtain your RHN password.

• For SLES installations, do the following:

– Determine the email address you want to use when you register with the
SUSE Customer Center.

– (Optional) Obtain the activation code for SLES components.

– (Optional) Determine the system name or description.

5. (Conditional) Gather SMN information.
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2: Installing the SGI UV System Software

Perform this step only if your SGI UV system includes an SMN. SGI UV 300
systems do not include an SMN. SGI UV 2000, SGI UV 1000, and SGI UV 100
systems can include an SMN.

The following list shows the information you need to collect:

• SMN fully qualified domain name (FQDN)
__________________________________

• SMN hostname __________________________________

• SMN IP address __________________________________

• SMN subnet mask __________________________________

• Password for the SMN’s system administrator (root user) login
__________________________________

6. Familiarize yourself with the hardware components in the rack.

If you have an SGI UV 300 system, identify the chassis in the rack and the DVD
drive on the chassis. Figure 2-1 on page 11 shows the location of the DVD drive,
along with some other equipment, on the SGI UV 300 chassis.
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ETH0

DVD driveUSB ports (4)

NUMAlink
ports (28)

VGA port MGMT

RMCSerial port
Optional 1.8-inch
SSD drive bays

System drive assembly

Figure 2-1 SGI UV 300 Chassis

If you have an SGI UV 2000, SGI UV 1000, or SGI UV 100 system, identify the
System Management Node (SMN), if present.

Figure 2-2 and Figure 2-3 show the location of the SMN in an SGI UV 2000
system rack and in an SGI UV 1000 system rack. The SMN is located either in the
top 1U slot between the individual rack units (IRUs) or at the top of the rack.
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2: Installing the SGI UV System Software

Individual Rack Unit (IRU)

(System Management Node)

1U (I/O) Expansion Slot

UV Rack

IRU

IRU

IRU

IRU

Figure 2-2 SGI UV 2000 System Rack
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Boot Disk Riser

Base I/O Riser

Power Supplies Power Supplies

Individual 
Rack Unit 
(IRU)

Individual 
Rack Unit 
(IRU)

1U (I/O) Expansion Slots

Compute Blades

Compute Blades

Compute Blades

Router Fans

Router Fans

System Management Node

Figure 2-3 SGI UV 1000 System Rack
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2: Installing the SGI UV System Software

When you begin the installation, instructions direct you to insert the installation
DVD into the SMN and press the power button. As Figure 2-4 on page 14 shows,
the DVD drive is on the left of the SMN.

DVD Power

UID
RESET

Figure 2-4 SMN Power Button and DVD Drive

7. (Conditional) Attach peripherals to the SMN.

Perform this step if your SGI UV system has an SMN.

Attach a keyboard, monitor, and mouse. The SMN includes USB ports into which
you can plug the peripherals.

8. Proceed to one of the following:

• (Optional) To set an administrative password for the local console, proceed to
the following:

"(Optional) Setting or Changing an Administrative Password on the Console"
on page 15

SGI does not require that you set an administrative password, but you can do
so if you are logged into a direct-attached, local console. After you set this
password, you can proceed with the software installation.

• To install the operating system, the SGI Foundation Software, and the SMN
software on an SMN, proceed to the following:

"(Conditional) Installing the System Software on the SMN" on page 21

• To install the operating system and SGI Foundation Software on an SGI UV
server, proceed to the following:

"Installing the System Software on the Server" on page 22
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(Optional) Setting or Changing an Administrative Password on the Console
The procedures in the following topics explain how to set or change the
administrative password:

• "Setting or Changing the Password on an SGI UV 300 System" on page 15

• "Setting or Changing the Password on an SGI UV 2000, SGI UV 1000, or SGI UV
100 System" on page 18

Setting or Changing the Password on an SGI UV 300 System

The procedure in this topic explains how to set, or change, an administrative password
on the console attached to an SGI UV 300 system. A password is not required.

To delete a console password, type the following command, which clears the EFI
variables:

RMC> power -c reset

If you delete the password with the power -c reset command, you need to go
back through the setup screens to set it again.

Procedure 2-2 To set or change an administrative password on the console

1. Log into the SGI UV 300 system as the root user.

2. (Conditional) Shut down the system.

Complete this step if the system is running at this time.

Type the following command:

# shutdown now

3. Log into the SGI UV 300’s rack management controller (RMC) as the root user.

4. From the RMC, type the following command to reset the power:

RMC> power -s reset

5. Wait for the reset to complete and type the following command to start a console
session on the base I/O BMC:

RMC> uvcon

6. On the console’s SGI UV 300 series BIOS main menu, press F2.

007–5948–006 15



2: Installing the SGI UV System Software

This action selects to enter setup and select boot options.

Figure 2-5 on page 16 shows the SGI UV 300 series BIOS menu options.

Figure 2-5 SGI UV 300 Boot Manager Screen

7. On the boot manager screen, select Device Manager, and press Enter.

Figure 2-6 on page 17 shows the device manager screen.
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Figure 2-6 SGI UV 300 Device Manager Screen

8. On the Device Manager screen, select Security, and press Enter.

The following list shows how to navigate the device manager:

• F1 scrolls the help.

• Shift-6(^), v, or arrow keys highlight a selection.

• F9 resets system defaults.

• Enter selects.
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• F10 saves.

• Esc exits without saving.

• Plus (+) and minus (-) keys change setting values.

• To exit the console, press CTRL and the right bracket (]) together, and then
press q. This sequence drops you to the RMC console.

9. On the Security screen, select the Admin Password option, and press Enter.

10. In the Please type in your new password field, type the new administrative
password, and press Enter.

The minimum password length is 6 characters and the maximum password
length is 30 characters. The password is case sensitive.

The next time you boot the system, the system will prompt you to type the new
password at the end of the boot sequence. The system issues this prompt before
the Shell> prompt appears.

11. Press F10 to save the change.

12. Press Esc twice to return to the boot manager.

13. To return to the RMC console, press CTRL and the right bracket (]) together, and
then press q.

14. Proceed to the following:

"Installing the System Software on the Server" on page 22

Setting or Changing the Password on an SGI UV 2000, SGI UV 1000, or SGI UV 100 System

The procedure in this topic explains how to set, or change, an administrative
password on the console attached to an SGI UV 2000, SGI UV 1000, or SGI UV 100
system. A password is not required.

To delete a console password, type the following command, which clears the EFI
variables:

system-cmc CMC:r001i01c> power -c reset

If you delete the password with the power -c reset command, you need to go
back through the setup screens to set it again.
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Procedure 2-3 To set or change an administrative password on the console

1. Log into the SGI UV system as the root user.

2. (Conditional) Shut down the system.

Complete this step if the system is running at this time.

Type the following command:

# shutdown now

3. Log into the SGI UV system’s chassis management controller (CMC) as the root
user.

4. From the CMC, type the following command to reset the power:

system-cmc CMC:r001i01c> power -s reset

5. Wait for the reset to complete and type the following command to start a console
session on the base I/O BMC:

system-cmc CMC:r001i01c> uvcon

6. At the console’s Hit [Space] for Boot Menu prompt, press the space bar.

7. On the boot manager screen, select Device Manager, and press Enter.

Figure 2-7 shows the boot manager screen.
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Figure 2-7 SGI UV 2000, SGI UV 1000, or SGI UV 100 Boot Manager Screen

8. On the Device Manager screen, select Security, and press Enter.

The following list shows how to navigate the device manager:

• F1 scrolls the help.

• Shift-6(^), v, or arrow keys highlight a selection.

• F9 resets system defaults.

• Enter selects.

• F10 saves.

• Esc exits without saving.

• Plus (+) and minus (-) keys change setting values.

• To exit the console, press CTRL and the right bracket (]) together, and then
press q. This sequence drops you to the CMC console.

9. On the Security screen, select the Admin Password option, and press Enter.

10. In the Please type in your new password field, type the new administrative
password, and press Enter.
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The minimum password length is 6 characters and the maximum password
length is 30 characters. The password is case sensitive.

The next time you boot the system, the system will prompt you to type the new
password at the end of the boot sequence. The system issues this prompt before
the Shell> prompt appears.

11. Press F10 to save the change.

12. Press Esc twice to return to the boot manager.

13. To return to the CMC console, press CTRL and the right bracket (]) together, and
then press q.

14. Proceed to one of the following:

• To install the operating system and SGI Foundation Software on an SMN,
proceed to the following:

"(Conditional) Installing the System Software on the SMN" on page 21

• To install the operating system and SGI Foundation Software on an SGI UV
server, proceed to the following:

"Installing the System Software on the Server" on page 22

(Conditional) Installing the System Software on the SMN
Perform the procedure in this topic if you have an SGI UV 2000 system with an SMN
or an SGI UV 1000 system with an SMN.

Perform all SMN software installations from the local console that is attached directly
to the SMN. You cannot install software on the SMN from a remote console.

The following procedure explains how to enable local console access and points to the
documentation that explains how to install the operating system software on the SMN.

Procedure 2-4 To enable access to the SMN from the local console and install the operating
system software

1. Insert the operating system DVD into the DVD drive on the SMN.

2. Press CTRL-ALT-F2 to get to tty2.

3. Log in as root.
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4. Type reboot.

5. Start the installer.

This step differs, depending on the operating system you want to install, as
follows:

• To install a RHEL SMN, on the Welcome to Red Hat Enterprise Linux 6.X
screen, position the cursor at Install or upgrade an existing system, and press
Enter.

• To install a SLES SMN, on the SLES boot menu, select Installation.

6. Proceed to one of the following:

• To install a RHEL 6 operating system, the SGI Foundation Software, and the
SMN software on the SMN, proceed to the following:

Chapter 3, "Installing a Red Hat Enterprise Linux (RHEL) 6 Platform" on page
35

• To install a SLES 11 operating system, the SGI Foundation Software, and the
SMN software on the SMN, proceed to the following:

Chapter 5, "Installing a SLES 11 Platform" on page 65

Note: SGI support RHEL 6 and SLES 11 on SMNs. SGI does not support RHEL7 or
SLES 12 on SMNs.

Installing the System Software on the Server
You can install the SGI UV server software by going through the SMN or by making
a direct connection to the SGI UV server. Perform one of the following procedures to
create an installation environment and to install the software on the SGI UV server:

• "Installing the SGI UV System Software on an SGI UV 300 Server" on page 23

• "Installing the SGI UV System Software on an SGI UV 2000, SGI UV 1000, or SGI
UV 100 Server With an SMN" on page 24

• "Installing the SGI UV System Software on an SGI UV 2000, SGI UV 1000, or SGI
UV 100 Server Without an SMN" on page 31
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Installing the SGI UV System Software on an SGI UV 300 Server

Perform the procedure in this topic if you have an SGI UV 300 server.

Procedure 2-5 To install the SGI UV 300 server software

1. Log into the remote management console (RMC) as the root user.

2. From the RMC, power-on the server.

3. Put the DVD in to the DVD drive in the chassis.

If you are installing the software on a partitioned SGI UV 300 system, put the
DVD into the drive in the chassis that includes the base I/O riser for your
partition.

For information about partitioning, see the following:

SGI Foundation Software (SFS) User Guide

4. From the RMC, type the following command to perform a quick reset:

# power -s reset

The quick reset in this step sets the system to its smallest possible configuration.
A later procedure includes a step to reset the whole system.

5. Wait for the system to reset.

The reset is complete when the RMC> prompt appears.

6. At the RMC> prompt, type the following command to open a console to the shell:

RMC> uvcon

7. At the SGI UV 300 series BIOS menu, press F2 to enter setup and select boot
options.

8. Use the arrow keys to highlight Boot Manager Menu, and press Enter

9. Use the arrow keys to highlight UEFI JMicron USB to ATA/ATAPI bridge ..., and
press Enter.

10. (Conditional — RHEL 7 or SLES 11 only) Select an installation activity, as follows:

• For a RHEL 7 installation, use the arrow keys to navigate to the Install Red
Hat Enterprise Linux 7.1, and press Enter.
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• For a SLES 11 installation, on the SUSE Linux Enterprise Server x screen,
press Enter to select Installation and start the SLES installation.

11. Proceed to one of the following:

• To install a RHEL 6 operating system and the SGI Foundation Software on an
SGI UV server, proceed to the following:

Chapter 3, "Installing a Red Hat Enterprise Linux (RHEL) 6 Platform" on page
35

• To install a RHEL 7 operating system and the SGI Foundation Software on an
SGI UV server, proceed to the following:

Chapter 4, "Installing a Red Hat Enterprise Linux (RHEL) 7 Platform" on page
53

• To install a SLES 11 operating system and the SGI Foundation Software on an
SGI UV server, proceed to the following:

Chapter 5, "Installing a SLES 11 Platform" on page 65

• To install a SLES 12 operating system and the SGI Foundation Software on an
SGI UV server, proceed to the following:

Chapter 6, "Installing a SLES 12 Platform" on page 85

Installing the SGI UV System Software on an SGI UV 2000, SGI UV 1000, or SGI UV 100
Server With an SMN

Perform the procedure in this topic if you have an SGI UV server with an SMN.

The following procedure explains how to access the server and points to the
documentation that explains how to install the operating system software on the
server.

Procedure 2-6 To install the SGI UV server software through the SMN

1. Log into the SMN as the root user.

2. From the system management node (SMN), establish a secure network connection
to the chassis management controller (CMC) of your SGI UV system.

For information about how to connect to the CMC, use one of the methods in the
SGI UV CMC Software User Guide.

24 007–5948–006



SGI
®

UV
TM

System Software Installation and Configuration Guide

3. Open an ssh connection to the baseboard management controller (BMC).

This step differs depending on whether your goal is to install an operating system
on an unpartitioned, single system image (SSI) SGI UV system or whether your
goal is to install an operating system on a partition of an SGI UV system that is
currently divided into partitions, as follows:

• To install onto an unpartitioned SSI, complete the following steps:

– On an SGI UV 2000 system, type the following command:

uv44-cmc CMC:r001i01c> ssh bmc0

– On an SGI UV 1000 system, type the following command:

uv44-cmc CMC:r001i01c> ssh bmc0i

• To install onto a partition, use the ssh command and specify the base I/O
BMC name for the desired partition.

For information about how to select a partition, see the following:

SGI Foundation Software (SFS) User Guide

For example, to continue the example from the previous step, to connect to
P001, type the following command:

uv44-cmc CMC:r001i01c> ssh r001i01b00

4. Retrieve the IP address of the BMC.

This step differs, depending on your platform, as follows:

• For SGI UV 2000 systems, type the following command to retrieve the IP
address of eth2 on the BMC:

r001i01b00> ifconfig eth2

For example, the following output shows that 128.162.246.190 is the IP
address of eth2:

BMC:r001i01b00> ifconfig eth2
eth2 Link encap:Ethernet HWaddr 08:00:69:16:82:2B

inet addr:128.162.246.190 Bcast:128.162.246.255 Mask:255.255.255.0

inet6 addr: fe80::a00:69ff:fe16:822b/64 Scope:Link

UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1

RX packets:21326174 errors:1250 dropped:2 overruns:0 frame:1248
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TX packets:25887 errors:0 dropped:0 overruns:0 carrier:4
collisions:0 txqueuelen:1000

RX bytes:1733795498 (1.6 GiB) TX bytes:9314062 (8.8 MiB)

Interrupt:60 Base address:0x800 DMA chan:ff

• For SGI UV 1000 systems, type the following command to retrieve the IP
address of eth1 on the BMC:

BMC:r001i01b00i> ifconfig eth1

For example, the following output shows that 172.20.255.254 is the IP address
of eth1:

r001i01b00i> ifconfig eth1

eth1 Link encap:Ethernet HWaddr 08:00:69:15:C0:57
inet addr:172.20.255.254 Bcast:172.20.255.255 Mask:255.255.0.0

UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1

RX packets:1508779 errors:204 dropped:28 overruns:0 frame:204

TX packets:2262923 errors:0 dropped:0 overruns:0 carrier:0

collisions:0 txqueuelen:1000
RX bytes:924130317 (881.3 MiB) TX bytes:3017177156 (2.8 GiB)

Interrupt:1

5. Note the IP address of eth2 on the BMC (for SGI UV 2000 systems) or eth1 on the
BMC (for SGI UV 1000 systems).

Keep the IP address in a safe place. You need this IP address during the
installation session and for future installation sessions.

6. On the desktop, click Computer > Firefox.

7. In the Firefox address bar, type the IP address of eth2 (on an SGI UV 2000
system) or eth1 (on an SGI UV 1000 system) on the BMC.

For example:

http://172.20.255.254

8. On the login screen, log into the system.

On an SGI UV 2000 system, type admin as the username, type admin as the
password, and press Enter.

On an SGI UV 1000 system, type root as the username, type superuser as the
password, and press Enter.
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The system might issue a Java prompt at this point. Address any Java prompts
that the system displays.

9. Launch the console.

This step differs depending on whether you want to install software on an SGI
UV 2000 or an SGI UV 1000.

On an SGI UV 2000 system, on the Dashboard screen, click Launch.

On an SGI UV 1000 system, on the Altix UV screen, complete the following steps:

• Click Remote Control.

• Click Console Redirection.

• Click Launch Console.

10. (Conditional) Enable Firefox pop-ups.

Perform this step if Firefox displays a message about pop-ups.

Perform the following steps:

• Click Preferences.

• Click Allow pop-ups for ip_address.

• Click Launch again.

11. On the Opening jviewer.jnlp ... screen, click OK.

12. On the Warning — Security: The web site’s certificate cannot be verified ...
screen, complete the following steps:

• Check Always trust content from this publisher.

• Click Yes.

13. On the Warning — Security: The application’s digital signature cannot be
verified ... screen, complete the following steps:

• Check Always trust content from this publisher.

• Click Run.

14. Launch the virtual media wizard.
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This step differs on SGI UV 2000 and SGI UV 1000 systems.

On SGI UV 2000 systems, complete the following steps:

• In the top-most JViewer menu bar, click Media > Virtual Media Wizard ....

• Insert the operating system DVD into the DVD drive on the SMN, or if you
are at a remote console, insert the DVD into your local desktop.

• On the Virtual Media pop-up, under CD/DVD Media 1, complete the
following steps:

– Select the device that corresponds to your DVD drive.

Your choice is /dev/device, where device depends on your system. For
example, select /dev/sr0.

– Click Connect to CD/DVD.

• On the Information pop-up, click OK.

• On the Virtual Media pop-up, click Close.

On SGI UV 1000 systems, complete the following steps:

• Insert the operating system DVD into the DVD drive on the SMN, or if you
are at a remote console, insert the DVD into your local desktop.

• In the JViewer main menu, select Device > Redirect CDROM.

• On the CD-ROM Selection pop-up, select a drive.

For example, select /dev/scd0.

• Click OK.

15. In a terminal window, establish a secure connection to the SGI UV server.

For example:

ssh root@uv_server_name

16. Type the following command to shut down the system:

shutdown now

This command drops you into single-user mode. Wait for the root prompt (#) to
appear.
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17. In a terminal window, establish a secure connection to the CMC.

For example:

ssh root@cmc_name

18. (Conditional) Boot the system.

Perform this step if you want to install software onto an unpartitioned SGI UV
system or if you want to install software on an SMN. Do not perform this step if
you want to install an operating system on a single partition.

The CMC command you need to boot the system differs slightly, depending on
whether you want to boot an SSI or whether you want to boot a partition. The
formats are as follows:

• For an SSI, type the following command to boot the system as a single blade:

CMC:r001i01c> power -s reset

• For a specific partition, type the power command in the following format:

power -s reset number

For number, specify the partition number.

For example, to boot partitions 1 and 2, type the following commands:

CMC:r001i01c> power -s reset p1

CMC:r001i01c> power -s reset p2

19. Press the space bar after a message similar to the following appears in the
JViewer window:

133,110,038,528 bytes of system memory tested OK

Hit [Space] for Boot Menu...

If you miss the opportunity to press the space bar, and you arrive at the EFI shell,
type exit to return to the boot manager.

20. Use the arrow keys to select Boot Manager, and press Enter.

21. On the Boot Manager screen, use the down-arrow key to select or highlight EFI
USB Device, and press Enter.

007–5948–006 29



2: Installing the SGI UV System Software

Several minutes might elapse before the system begins to boot. A series of
question mark characters might appear on the screen during the system boot.
This is a known problem, and you can ignore it safely.

22. (Conditional) Configure the accelerated boot process. (RHEL platform SGI UV
servers only)

Perform this step only if you inserted a RHEL DVD into the DVD drive on an
SGI UV server. Failure to accelerate the boot process can result in boots that last
twenty minutes or more on RHEL platforms. You do not need to perform this
step on an SMN.

Complete the following steps:

• On the Press any key for the boot menu ... screen, press Enter.

• On the GNU GRUB menu, verify that Red Hat Enterprise Linux ... is selected,
and type e to edit the Red Hat Enterprise Linux commands before booting.

• On the GNU GRUB menu, verify that kernel / ... is selected, and type e to
edit the kernel.

• At the end of the grub edit > line that contains the default boot options, type
a space character and then type the following additional boot option:
ipmi_si.trydefaults=0

Press Enter when you finish typing the additional boot option.

• On the GNU GRUB menu, type b to boot RHEL with the additional boot
options.

23. Proceed to one of the following:

• To install a RHEL 6 operating system and the SGI Foundation Software on an
SGI UV server, proceed to the following:

Chapter 3, "Installing a Red Hat Enterprise Linux (RHEL) 6 Platform" on page
35

• To install a RHEL 7 operating system and the SGI Foundation Software on an
SGI UV server, proceed to the following:

Chapter 4, "Installing a Red Hat Enterprise Linux (RHEL) 7 Platform" on page
53
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• To install a SLES 11 operating system and the SGI Foundation Software on an
SGI UV server, proceed to the following:

Chapter 5, "Installing a SLES 11 Platform" on page 65

• To install a SLES 12 operating system and the SGI Foundation Software on an
SGI UV server, proceed to the following:

Chapter 6, "Installing a SLES 12 Platform" on page 85

Installing the SGI UV System Software on an SGI UV 2000, SGI UV 1000, or SGI UV 100
Server Without an SMN

Perform the procedure in this topic if you have any of the following:

• SGI UV 2000 without an SMN

• SGI UV 1000 without an SMN

• SGI UV 100 without an SMN

Procedure 2-7 To install the SGI UV server software without an SMN

1. Notify users that they need to log off.

The software installation process includes a step to reboot the system. If any
users are logged in at this time, their sessions end.

2. From a workstation, complete the following steps:

• Log into the SGI UV server as the root user.

• Open a terminal window to the SGI UV server.

• Issue the following command to shut down the operating system:

# shutdown now

3. Compete the following steps to power off the SGI UV server:

• In a terminal window, establish a secure connection to the CMC.

For example:

$ ssh root@cmc_name

Provide the root user’s password when prompted.
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• Type the following command to power off the computer system:

> power off

If you are installing the operating system on a partition, repeat this step through
Procedure 2-7, step 10 on page 32, for each partition.

4. Attach a keyboard, a monitor, and a mouse directly to the SGI UV server.

5. Attach a DVD drive to the SGI UV server.

6. Insert the operating system DVD into the USB DVD drive on the SGI UV server.

7. Complete the following steps to power on the SGI UV server:

• In a terminal window, establish a secure connection to the CMC.

For example:

$ ssh root@cmc_name

Provide the root user’s password when prompted.

• Type the following command to power on the computer system:

> power on

8. Press the space bar after a message similar to the following appears:

133,110,038,528 bytes of system memory tested OK

Hit [Space] for Boot Menu...

9. Use the arrow keys to select Boot Manager, and press Enter.

10. On the Boot Manager screen, use the down-arrow key to select or highlight EFI
USB Device, and press Enter.

Several minutes might elapse before the system begins to boot. A series of
question mark characters might appear on the screen during the system boot.
This is a known problem, and you can ignore it safely.

11. (Conditional) Configure the accelerated boot process. (RHEL 6.5 platform SGI UV
servers only)

Perform this step only if you inserted a RHEL 6.5 DVD into the DVD drive on an
SGI UV server. Failure to accelerate the boot process can result in boots that last
twenty minutes or more on RHEL 6.5 platforms. You do not need to perform this
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step on an SMN. You do not need to perform this step if you are installing RHEL
6.6.

Complete the following steps:

• On the Press any key for the boot menu ... screen, press Enter.

• On the GNU GRUB menu, verify that Red Hat Enterprise Linux ... is selected,
and type e to edit the Red Hat Enterprise Linux commands before booting.

• On the GNU GRUB menu, verify that kernel / ... is selected, and type e to
edit the kernel.

• At the end of the grub edit > line that contains the default boot options, type
a space character and then type the following additional boot option:
ipmi_si.trydefaults=0

Press Enter when you finish typing the additional boot option.

• On the GNU GRUB menu, type b to boot RHEL with the additional boot
options.

12. Proceed to one of the following:

• To install a RHEL 6 operating system and the SGI Foundation Software on an
SGI UV server, proceed to the following:

Chapter 3, "Installing a Red Hat Enterprise Linux (RHEL) 6 Platform" on page
35

• To install a RHEL 7 operating system and the SGI Foundation Software on an
SGI UV server, proceed to the following:

Chapter 4, "Installing a Red Hat Enterprise Linux (RHEL) 7 Platform" on page
53

• To install a SLES 11 operating system and the SGI Foundation Software on an
SGI UV server, proceed to the following:

Chapter 5, "Installing a SLES 11 Platform" on page 65

• To install a SLES 12 operating system and the SGI Foundation Software on an
SGI UV server, proceed to the following:

Chapter 6, "Installing a SLES 12 Platform" on page 85
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Chapter 3

Installing a Red Hat Enterprise Linux (RHEL) 6
Platform

This chapter includes the following topics:

• "About Installing the RHEL Operating System on an SGI UV System" on page 35

• "Installing the RHEL Operating System Software on an SGI UV Server or an SGI
UV SMN" on page 36

• "Installing the SGI Foundation Software on a RHEL Platform SGI UV Server or a
RHEL Platform SMN" on page 48

• "(Conditional) Installing the SMN Software on a RHEL Platform SMN (SGI UV
2000, SGI UV 1000, and SGI UV 100 Platforms Only)" on page 51

About Installing the RHEL Operating System on an SGI UV System
This chapter explains how to install and configure the following software on an SGI

®

UV
TM

server and on an SGI UV system management node (SMN):

• The RHEL operating system. The operating system installation instructions are
nearly identical for the SGI UV server and the SMN. The instructions note
differences where necessary.

• The SGI Foundation Software. The SGI Foundation Software installation
instructions are nearly identical for the SGI UV server and the SMN. The
instructions note differences where necessary.

• The SMN software. This is an SMN-specific package. SGI UV 2000, SGI UV 1000,
and SGI UV 100 computers can have an SMN. The SGI UV 300 computers do not
have SMNs.

Note: SGI supports only the RHEL 6 operating system on the SMN. If your SGI
UV system includes an SMN, use the procedures in this chapter to install RHEL 6
as the operating system on the SMN and to install the latest SGI Foundation
Software and SMN software.
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The following additional documentation might be useful to you during this
installation process:

• The Red Hat Enterprise Linux 6 Installation Guide. This guide is available at the
following location:

http://docs.redhat.com/docs/en-
US/Red_Hat_Enterprise_Linux/6/pdf/Installation_Guide/Red_Hat_Enterprise_Linux-
6-Installation_Guide-en-US.pdf

• The SGI Foundation Software 2.X release notes file. After you log into
Supportfolio, you can retrieve the release notes from the following location:

https://support.sgi.com/content_request/194480/index.html

• The SMN software release notes file. After you log into Supportfolio, you can
retrieve the release notes from the following location:

https://support.sgi.com/content_request/738299/index.html

Installing the RHEL Operating System Software on an SGI UV Server or an
SGI UV SMN

The following procedures explain how to install the RHEL operating system software:

• "Initiating the Installation" on page 36

• "Specifying the Network" on page 37

• "(Conditional) Specifying Disk Partitions for an SGI UV SMN" on page 39

• "Specifying Disk Partitions for an SGI UV Server" on page 42

• "Completing the RHEL Installation" on page 46

Initiating the Installation

The following procedure explains how to initiate the installation.

Procedure 3-1 To begin the software installation

1. Make sure you gathered the information that you need for this installation.

For more information, see the following:
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"Gathering Installation Materials and Information" on page 7

2. On the Disc Found screen, tab to one of the following, and press Enter:

• Skip. Select this option if you are using the standard DVD you received from
SGI.

• OK. Select this option if you downloaded the software and created your own
DVD. This option checks the integrity of the disk.

3. On the Red Hat Enterprise Linux 6 splash screen, click Next.

4. On the What language would you like to use during the installation process?
screen, select your language, and click Next.

5. On the Select the appropriate keyboard for the system screen, select your
keyboard, and click Next.

6. On the What type of devices will your installation involve? screen, select Basic
storage devices, and click Next.

7. (Conditional) Select Fresh Installation, and select Next.

Perform this step if a screen with the following information appears: At least one
existing installation has been detected on your system. What would you like to
do?

8. On the Please name this computer screen, type the fully qualified domain name
(FQDN) for the SMN, and click Configure Network.

If you are installing the operating system on a partition, make sure to use a
different hostname for each partition you create. For example:
system-p1.uv.com. After you complete the installation, if you need to address
a partition, use the hostname or FQDN for the partition.

9. Proceed to the following:

"Specifying the Network" on page 37

Specifying the Network

The following procedure explains how to specify the networking information.

Procedure 3-2 To specify the network

1. On the Network Connections popup, select System eth0, and click Edit.
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2. On the Editing System eth0 popup, complete the following steps:

• Select Connect automatically to start the network card.

• Select the IPv4 Settings tab.

3. Complete the IPv4 Settings tab.

This step differs depending on whether you want to use dynamic or static
addressing, as follows:

To specify dynamic addressing: To specify static addressing:

1. Make sure that Automatic (DHCP) is
selected.

1. In the Method: field, pull down
Manual.

2. Click Apply. 2. In the Addresses pane, click Add,
and complete the following steps:

• Type the IP address.
• Type the netmask.
• Type the IP address of the default

gateway.

3. On the Network Connections
pop-up, click Close.

3. In the DNS servers: field, type the IP
address of one or more DNS servers. If
you specify more than one, use a comma
to separate each IP address.

4. In the Search domains: field, type
one or more search domains. If you
specify more than one, use a comma to
separate each domain.

5. Click Apply.

6. On the Network Connections
pop-up, click Close.

4. On the Please name this computer screen, click Next.

5. On the Please select the nearest city in your time zone screen, select a city, and
click Next.
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6. On the The root account is used for administering the system screen, complete
the following steps:

• In the Root Password field, type the password you want to use for the root
account.

• In the Confirm field, type the root password again.

• Click Next.

7. On the Which type of installation would you like? screen, select Create Custom
Layout, and click Next.

8. Proceed to one of the following:

• To configure disk partitions on an SMN, complete the following procedure:

"(Conditional) Specifying Disk Partitions for an SGI UV SMN" on page 39

• To configure disk partitions on an SGI UV server, complete the following
procedure:

"Specifying Disk Partitions for an SGI UV Server" on page 42

(Conditional) Specifying Disk Partitions for an SGI UV SMN

Perform the procedure in this topic if you need to configure an SGI UV SMN.

This topic includes information about disk partitioning for SGI UV system SMNs.
The procedure in this topic explains how to configure the disk partitions and monitor
a reboot.

For the SMN, your goal is to configure the disks according to Table 3-1 on page 39.
Note that the system automatically creates an Extended partition.

Table 3-1 Disk Partitions for an SGI UV SMN

Size Mount Point File System

200 MB /boot ext4

250 GB (256,000 MB) / ext4
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Size Mount Point File System

8 GB (8,192 MB) swap swap

rest of disk /data1 ext4

The following procedure explains how to specify the disk partitions.

Procedure 3-3 To specify disk partitions

1. On the main disk partitioning screen, complete the following steps to clean the
disk:

• Select a disk device.

• Click Delete.

• On the Confirm Delete pop-up, click Delete.

• Proceed to the next step after you have deleted all existing partitions.

2. On the main disk partitioning screen, click Create.

3. On the Create Storage pop-up, complete the following steps:

• Click Standard Partition.

• Click Create.

4. On the Add Partitions pop-up, complete the following steps:

• In the Mount Point field, select /boot from the pull-down menu.

• In the File System Type field, select ext4 from the pull-down menu.

• Verify that the default size is 200 MB.

• Verify that Fixed size is selected.

• Verify that Encrypt is clear.

Note: Do not check Encrypt.

• Click OK.

5. On the main disk partitioning screen, click Create.
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6. On the Create Storage pop-up, click Create.

7. On the Add Partition pop-up, complete the following steps:

• In the Mount Point field, select / from the pull-down menu.

• In the File System Type field, verify that ext4 appears.

• In the Size field, type 256000, which is 250 GB.

• Verify that Fixed size is selected.

• Verify that Encrypt is clear.

Note: Do not check Encrypt.

• Click OK.

8. On the main disk partitioning screen, click Create.

9. On the Create Storage pop-up, click Create.

10. On the Add Partition pop-up, complete the following steps:

• In the File System Type field, select swap from the pull-down menu.

• In the Size field, type 8192, which is 8 GB.

• Verify that Fixed size is selected.

• Verify that Encrypt is clear.

Note: Do not check Encrypt.

• Click OK.

11. On the main disk partitioning screen, click Create.

12. On the Create Storage pop-up, click Create.

13. On the Add Partition pop-up, complete the following steps:

• In the Mount Point field, type /data1.

• In the File System Type field, select ext4 from the pull-down menu.
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• In the Additional Size Options box, select Fill to maximum allowable size.

• Verify that Encrypt is clear.

Note: Do not check Encrypt.

• Click OK.

14. On the main disk partitioning screen, click Next.

15. On the Writing Storage Configuration to disk pop-up, select Write changes to
disk.

Wait for the disk formatting to complete.

16. On the boot loader specifications page, complete the following steps:

• Verify that the Use boot loader password box is clear.

• In the Boot loader operating system list box, verify that Red Hat Enterprise
Linux ... appears.

• Click Next.

17. Proceed to the following:

"Completing the RHEL Installation" on page 46

Specifying Disk Partitions for an SGI UV Server

Perform the procedure in this topic to configure the partitions for an SGI UV server.

This topic includes information about disk partitioning for SGI UV servers. The
procedure in this topic explains how to configure the disk partitions and monitor a
reboot.

For the SGI UV server, your goal is to configure the disks according to Table 3-2 on
page 43
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Table 3-2 Disk Partitions for an SGI UV Server

Size Mount Point File System

500 MB /boot/efi EFI System Partition

250 GB (256,000 MB) / ext4

8 GB (8,192 MB) swap swap

rest of disk /data1 ext4

The following procedure explains how to specify the disk partitions.

Procedure 3-4 To specify disk partitions

1. On the Please Select a Device screen, which is the main disk partitioning screen,
complete the following steps to clean the disk:

• Select a disk device.

• Click Delete.

• On the Confirm Delete pop-up, click Delete.

• Proceed to the next step after you have deleted all existing partitions.

2. On the Please Select a Device screen, which is the main disk partitioning screen,
click Create.

3. On the Create Storage pop-up, complete the following steps:

• Click Standard Partition.

• Click Create.

4. On the Add Partition pop-up, complete the following steps:

• In the Mount Point field, select /boot/efi from the pull-down menu.

• Verify that EFI System Partition is selected.

• In the Size field, type 500, which is 500 MB.

• Verify that Fixed size is selected.

• Verify that Encrypt is clear.
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Note: Do not check Encrypt.

• Click OK.

5. On the Please Select a Device screen, which is the main disk partitioning screen,
click Create.

6. On the Create Storage pop-up, complete the following steps:

• Click Standard Partition.

• Click Create.

7. On the Add Partition pop-up, complete the following steps:

• In the Mount Point field, select / from the pull-down menu.

• In the File System Type field, verify that ext4 appears.

• In the Size field, type 256000, which is 250 GB.

• Verify that Fixed size is selected.

• Verify that Encrypt is clear.

Note: Do not check Encrypt.

• Click OK.

8. On the Please Select a Device screen, which is the main disk partitioning screen,
click Create.

9. On the Create Storage pop-up, complete the following steps:

• Click Standard Partition.

• Click Create.

10. On the Add Partition pop-up, complete the following steps:

• In the File System Type field, select swap from the pull-down menu.

• In the Size field, type 8192, which is 8 GB.
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• Verify that Fixed size is selected.

• Verify that Encrypt is clear.

Note: Do not check Encrypt.

• Click OK.

11. On the Please Select a Device screen, which is the main disk partitioning screen,
click Create.

12. On the Create Storage pop-up, complete the following steps:

• Click Standard Partition.

• Click Create.

13. On the Add Partition pop-up, complete the following steps:

• In the Mount Point field, type /data1.

• In the File System Type field, select ext4 from the pull-down menu.

• In the Additional Size Options box, select Fill to maximum allowable size.

• Verify that Encrypt is clear.

Note: Do not check Encrypt.

• Click OK.

14. On the Please Select a Device screen, which is the main disk partitioning screen,
click Next.

15. On the Writing Storage Configuration to disk pop-up, select Write changes to
disk.

Wait for the disk formatting to complete.

16. On the boot loader specifications page, complete the following steps:

• Verify that the Use boot loader password box is clear.

• In the Boot loader operating system list box, verify that Red Hat Enterprise
Linux /dev/sda2 appears.
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• Click Next.

17. Proceed to the following:

"Completing the RHEL Installation" on page 46

Completing the RHEL Installation

The following procedure explains how to complete the installation.

Procedure 3-5 To complete the installation

1. On the The default installation of Red Hat Enterprise Linux is a basic server
install ... page, complete the following steps:

• Select Desktop.

• Select Next.

Wait for the operating system installation to complete.

2. On the Congratulations, your Red Hat Enterprise Linux installation is complete
page, click Reboot.

3. On the Welcome page, click Forward.

4. On the License Information page, complete the following steps:

• Click Yes, I agree to the License Agreement.

• Click Forward.

5. On the Set Up Software Updates page, decide whether to register now or
whether to postpone registration.

If your SGI UV system is connected to the network correctly, you can register
now. The following information explains how to proceed:

• If the screen contains a message that begins with This assistant will guide
you through the process of registering your system with Red Hat to receive
software updates ..., then the SGI UV system is connected correctly to the
network. Complete the following steps:

– Select Yes, I’d like to register now, and click Forward.
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– On the Choose Service page, select Red Hat Subscription Management,
and click Forward.

– On the Subscription Management Registration page, click Forward.

– On the second Subscription Management Registration page, complete the
fields appropriately for your site, and click Forward.

– On the third Subscription Management Registration page, click Forward.

• If the screen includes a warning symbol and a message that begins with The
network connection on your system is not active ..., then the SGI UV system
is not connected correctly to the network. Complete the following steps:

– Click Forward.

– Continue on to the next step in this procedure.

You can restart the installer, correct your network network configuration,
and connect to RHN later.

6. On the Create User page, complete the following steps to create an end-user
account:

• In the Username field, type the username.

• In the Full Name field, type the user’s full name.

• In the Password field, type the user’s password. Passwords must be at least
eight characters long, contain at least one digit, and contain a mixture of
uppercase and lowercase letters.

• In the Confirm Password field, type the user’s password again.

• Click Forward.

7. On the Date and Time screen, configure system clock settings that your site
requires and click Forward.

8. On the Kdump page, specify the following:

• For the SGI UV server, specify 1280 MB, and click Finish.

• For the SMN, specify 256 MB, and click Finish.

9. On the Changing Kdump ... pop-up, click Yes.
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10. On the The system must now reboot ... pop-up, click OK to confirm the reboot.

11. Proceed to the following:

"Installing the SGI Foundation Software on a RHEL Platform SGI UV Server or a
RHEL Platform SMN" on page 48

Installing the SGI Foundation Software on a RHEL Platform SGI UV Server
or a RHEL Platform SMN

The following procedure explains how to install the SGI Foundation Software on a
RHEL SGI UV server or SMN. You can use the same procedure on both the SGI UV
server and an SGI UV SMN.

Procedure 3-6 To install the SGI Foundation Software

1. Log into the SGI UV server or the SGI UV SMN as the root user.

The SGI Foundation Software installation procedure is the same for both the SGI
UV server and the SGI UV SMN.

2. On the login page, complete the following steps:

• Select Other.

• In the Username field, type root.

• In the Password field, type the root user’s password.

• Click Log In.

3. On the You are currently trying to run as the root super user ... pop-up, click
Close.

4. Access the installation software.

Complete this step in one of the following ways:

• If a DVD drive is available, insert the SGI Foundation Software X.X CD into the
DVD drive.

For example, an SGI UV 300 includes a DVD drive. You might have attached
a DVD drive to an SGI UV 2000 or SGI UV 1000 computer system.

• On an SGI UV 2000 without a DVD drive, complete the following steps:
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– In the top-most JViewer menu bar, click Media > Virtual Media Wizard ....

– Insert the operating system DVD into the DVD drive on the SMN, or if
you are at a remote console, insert the DVD into your local desktop.

– On the Virtual Media pop-up, under CD/DVD Media 1, complete the
following steps:

• Select /dev/sr0.

• Click Connect to CD/DVD.

– On the Information pop-up, click OK.

– On the Virtual Media pop-up, click Close.

• On an SGI UV 1000 without a DVD drive, complete the following steps:

– Insert the operating system DVD into the DVD drive on the SMN, or if
you are at a remote console, insert the DVD into your local desktop.

– In the JViewer main menu, select Device > Redirect CDROM.

– On the CD-ROM Selection pop-up, select a drive.

For example, select /dev/scd0.

– Click OK.

5. Click Applications > System Tools > Terminal to open a terminal window.

6. Type the following command to create an installation directory for the files from
the CD:

# mkdir -p /opt/sgi/Factory-Install/sgi-foundation-2.12/

7. Type the following command to create a temporary mount directory:

# mkdir /var/sfs2.12

8. Type the following command to mount the CD in read-only mode (-r), using a
loop device:

# mount -t iso9660 -ro loop /dev/cdrom /var/sfs2.12
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9. Type the following command to copy the files from the temporary mount
directory to the installation directory:

# rsync -avHx /var/sfs2.12/ /opt/sgi/Factory-Install/sgi-foundation-2.12/

10. Type the following command to unmount the CD from the temporary directory:

# umount /var/sfs2.12

11. Type the following command to remove the temporary mount directory:

# rmdir /var/sfs2.12

12. Use a text editor to create file
/etc/yum.repos.d/foundation2.12-local.repo with the following
contents:

########################################

[foundation2.12-repo]

name=SGI Foundation Software 2.12 - $basearch

baseurl=file:///opt/sgi/Factory-Install/sgi-foundation-2.12/RPMS
enabled=1

gpgcheck=1

gpgkey=file:///opt/sgi/Factory-Install/sgi-foundation-2.12/RPM-GPG-KEY-sgi

########################################

13. Type the following command to retrieve the list of software that you can install:

# yum grouplist | grep SGI

14. Type the following command to install the SGI Foundation Software group:

# yum groupinstall "SGI Foundation Software"

15. Type y at the following prompt to confirm the download size:

Is this ok [y/N]

16. Type y at the following prompt to accept the GPG license key:

Is this ok [y/N]

17. Open a terminal window on the booted system.

18. In the terminal window, type the following command to reboot the system:

# reboot
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19. After the system reaches the EFI shell, in the RMC or CMC command window,
type the following command to reset the full system:

# power reset

20. (Conditional) Install the SMN-specific specific software on the SMN.

Perform the following procedure to complete the SMN software installation:

"(Conditional) Installing the SMN Software on a RHEL Platform SMN (SGI UV
2000, SGI UV 1000, and SGI UV 100 Platforms Only)" on page 51

The SGI UV server installation is finished at this time.

(Conditional) Installing the SMN Software on a RHEL Platform SMN (SGI
UV 2000, SGI UV 1000, and SGI UV 100 Platforms Only)

Perform the procedure in this topic if your SGI UV server has an SMN.

The SMN requires its own specific software, and you need to install the SMN
software on the SMN after you install the SGI Foundation Software.

The following procedure explains how to install the SMN software on a RHEL SMN.

Procedure 3-7 To install the SMN software on a RHEL SMN

1. Insert the CD labeled SGI System Management Node Software X.X into the DVD
drive on the SMN.

2. Type the following command to create an installation directory for the files from
the CD:

# mkdir -p /opt/sgi/Factory-Install/sgi-smn-1.11/

3. Type the following command to create a temporary mount directory:

# mkdir /var/smn1.11

4. Type the following command to mount the CD in read-only mode (-r), using a
loop device:

# mount -ro loop /dev/cdrom /var/smn1.11
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5. Type the following command to copy the files from the temporary mount
directory to the installation directory:

# rsync -avHx /var/smn1.11/ /opt/sgi/Factory-Install/sgi-smn-1.11/

6. Type the following command to unmount the CD from the temporary directory:

# umount /var/smn1.11

7. Type the following command to remove the temporary mount directory:

# rmdir /var/smn1.11

8. Use a text editor to create file /etc/yum.repos.d/smn1.11-local.repo with
the following contents:

########################################

[smn1.11-repo]

name=SGI SMN Software 1.11 - $basearch

baseurl=file:///opt/sgi/Factory-Install/sgi-smn-1.11/RPMS

enabled=1
gpgcheck=1

gpgkey=file:///opt/sgi/Factory-Install/sgi-smn-1.11/RPM-GPG-KEY-sgi

########################################

9. Type the following command to retrieve the list of software that you can install:

# yum grouplist | grep SGI

10. Type the following command to install the SGI SMN software group:

# yum --enablerepo=rhel-6-server-optional-rpms groupinstall "SGI Management Node Software"

11. Type the following command to reboot the system:

# reboot

12. Log into the system as the root user.

13. Type the following command to configure the SMN software:

# smnconfig -Aa -3

14. Type the following command to reboot:

# reboot
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Installing a Red Hat Enterprise Linux (RHEL) 7
Platform

This chapter includes the following topics:

• "About Installing the RHEL Operating System on an SGI UV System" on page 53

• "Installing the RHEL Operating System Software on an SGI UV Server" on page 54

• "Installing the SGI Foundation Software on a RHEL 7-based SGI UV Server" on
page 61

About Installing the RHEL Operating System on an SGI UV System
This chapter explains how to install and configure the following software on an SGI

®

UV
TM

server:

• The RHEL 7.1 operating system.

• The SGI Foundation Software.

The following additional documentation might be useful to you during this
installation process:

• The Red Hat Enterprise Linux 7 Installation Guide. This guide is available at the
following location:

http://docs.redhat.com/docs/en-
US/Red_Hat_Enterprise_Linux/7/pdf/Installation_Guide/Red_Hat_Enterprise_Linux-
7-Installation_Guide-en-US.pdf

• The SGI Foundation Software 2.X release notes file. After you log into
Supportfolio, you can retrieve the release notes from the following location:

https://support.sgi.com/content_request/194480/index.html
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Note: If your SGI UV system includes a system management node (SMN), be aware
that SGI does not support the RHEL 7 operating system on the SMN. SGI supports
only the RHEL 6 operating system on the SMN, but SGI continues to update the SGI
Foundation Software and the SMN software for use on RHEL 6-based SMNs. To
install the system software on an SMN, use the procedures in the following chapter to
install the RHEL 6 operating system, the latest SGI Foundation Software, and the
latest SMN software:

Chapter 3, "Installing a Red Hat Enterprise Linux (RHEL) 6 Platform" on page 35

Installing the RHEL Operating System Software on an SGI UV Server
The following procedures explain how to install the RHEL operating system software:

• "Initiating the Installation and Partitioning the Disk" on page 54

• "Configuring the Network and Rebooting" on page 57

• "Completing the Installation" on page 59

Initiating the Installation and Partitioning the Disk

The following procedure explains how to initiate the installation.

Procedure 4-1 To begin the software installation

1. Make sure you gathered the information that you need for this installation.

For more information, see the following:

"Gathering Installation Materials and Information" on page 7

2. On the boot loader menu, complete the following steps:

• Use the arrow keys to select Install Red Hat Enterprise Linux 7.1.

• Press Enter.

3. Wait a few moments while the software loads.

4. On the splash screen, which asks What language would you like to use during
the installation process?, complete the following steps:
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• Select your language.

• Click Continue.

5. On the INSTALLATION SUMMARY page, click DATE & TIME.

6. On the DATE & TIME page, complete the following steps:

• Select your time zone.

• Select the date.

• Click Done.

7. On the INSTALLATION SUMMARY page, click KEYBOARD.

8. On the KEYBOARD LAYOUT page, complete the following steps:

• Select your keyboard layout.

• Click Done.

9. On the INSTALLATION SUMMARY page, click SOFTWARE SELECTION.

10. On the SOFTWARE SELECTION page, complete the following steps:

• Select Server with GUI.

• Click Done.

11. On the INSTALLATION SUMMARY page, complete the following steps:

• Click INSTALLATION DESTINATION.

• Click the disk under Local Standard Disks.

• Under Other Storage Options, click I will configure partitioning.

• Click Done.

12. On the MANUAL PARTITIONING page, clean the disk.

The screen’s left pane lists the operating system installations that currently reside
on the disk. Your goal is to remove all operating system installations, data, and
partitions that reside on the disk. You can remove one operating system at a time.

To remove one operating system, complete the following steps:

• Select the operating system’s name.
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• Click the minus sign (-) at the bottom of the left pane to delete the operating
system.

• On the Are you sure ... popup, complete the following steps:

– Select Delete all other ....

– Click Delete it.

• Repeat the preceding steps, as needed, until all operating systems are removed.

13. In the left pane, select Standard Partition from the drop-down menu.

14. Create new mount points.

Your goal is to configure the disks according to Table 4-1 on page 56.

Table 4-1 Disk Partitions for an SGI UV Server

Size Mount Point File System

512 MB /boot/efi FAT16

250 GB (256,000 MB) / XFS

8 GB (8,192 MB) swap swap

rest of disk /data1 XFS

Complete the following steps to create new mount points:

• In the left pane, click the plus sign (+) to add a new mount point.

• On the ADD A NEW MOUNT POINT popup, complete the following steps:

– On the Mount Point drop-down menu, select /boot/efi.

– On the Desired Capacity drop-down menu, type 512mb.

– Click Add mount point.

• In the left pane, click the plus sign (+) to add a new mount point.

• On the ADD A NEW MOUNT POINT popup, complete the following steps:

– On the Mount Point drop-down menu, select /.
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– On the Desired Capacity drop-down menu, type 250gb.

– Click Add mount point.

• In the left pane, click the plus sign (+) to add a new mount point.

• On the ADD A NEW MOUNT POINT popup, complete the following steps:

– On the Mount Point drop-down menu, select swap.

– On the Desired Capacity drop-down menu, type 8gb.

– Click Add mount point.

• In the left pane, click the plus sign (+) to add a new mount point.

• On the ADD A NEW MOUNT POINT popup, complete the following steps:

– In the Mount Point field, type /data1.

– Leave the Desired Capacity field blank.

– Click Add mount point.

• Verify that the Desired Capacity field shows the rest of the disk.

• Click Done.

15. On the SUMMARY OF CHANGES popup, click Accept Changes.

16. On the KDUMP page, complete the following steps:

• Click Manual.

• In the Memory to be Reserved (MB) field, specify 1280 MB.

• Click Done.

17. Proceed to the following:

"Configuring the Network and Rebooting" on page 57

Configuring the Network and Rebooting

The following procedure explains how to specify your network and reboot.
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Procedure 4-2 To configure the network and reboot

1. On the INSTALLATION SUMMARY page, click NETWORK & HOST NAME.

2. On the NETWORK & HOST NAME page, complete the following steps:

• Select Ethernet enp1s0f0.

• In the right pane, in the upper-right corner of the screen, find the ON/OFF
switch, and click the blank box to set the ON/OFF switch to ON.

• Click Configure.

• On the Editing enp1s0f0 popup, select IPv4 Settings.

• Complete this step according to the following table:

To specify dynamic addressing: To specify static addressing:

1. In the Method: drop-down menu,
select Automatic (DHCP).

1. In the Method: drop-down menu,
select Manual.

2. Click Apply. 2. In the Addresses pane, click Add,
and complete the following steps:

• Type the IP address.
• Type the netmask.
• Type the IP address of the default

gateway.

3. On the Editing pop-up, click Save. 3. In the DNS servers: field, type the IP
address of one or more DNS servers. If
you specify more than one, use a comma
to separate each IP address.

4. In the Search domains: field, type
one or more search domains. If you
specify more than one, use a comma to
separate each domain.

5. On the Editing pop-up, click Save.

3. On the NETWORK & HOSTNAME page, in the Host name field, complete the
following steps:

• Type the hostname of the SGI UV system.
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• Click Done.

4. On the INSTALLATION SUMMARY page, click Begin Installation.

5. On the CONFIGURATION page, click ROOT PASSWORD.

6. On the ROOT PASSWORD page, complete the following steps:

• In the Root Password field, type the password you want to use on this SGI
UV system.

• In the Confirm field, type the password again.

• Click Done.

If the password is too weak, either specify a stronger password or click Done
twice.

7. On the CONFIGURATION page, complete the following steps:

• Wait for the configuration to complete.

• Click Reboot when the configuration completes.

• Wait for the reboot to finish.

8. Proceed to the following:

"Completing the Installation" on page 59

Completing the Installation

The following procedure explains how to complete the installation.

Procedure 4-3 To complete the installation

1. On the INITIAL SETUP screen, click LICENSE INFORMATION.

2. On the LICENSE INFORMATION screen, complete the following steps:

• Click I accept the license agreement.

• Click Done.

3. Click FINISH CONFIGURATION.

4. On the Subscription Management Registration page, click Forward.
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5. On the second Subscription Management Registration page, complete the
following steps:

• Complete the fields appropriately for your site.

• Click Forward.

6. On the Welcome page, complete the following steps:

• Select your language.

• Click Next.

7. On the Input Sources page, complete the following steps:

• Select the language you use.

• Click Next.

8. On the Login page, complete the following steps to create the local user account:

• Complete all the fields on this page.

• Click Next.

9. On the Location page, complete the following steps:

• Select a location.

• Click Next.

10. On the Thank You screen, click Start using Red Hat Enterprise Linux Server.

11. Click the user account name in the upper right corner of your screen, and select
Log Out on the menu that appears.

This action logs out the local user, which is the account you created in this
procedure.

12. Proceed to the following:

"Installing the SGI Foundation Software on a RHEL 7-based SGI UV Server" on
page 61
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Installing the SGI Foundation Software on a RHEL 7-based SGI UV Server
The following procedure explains how to install the SGI Foundation Software on a
RHEL SGI UV server or SMN. You can use the same procedure on both the SGI UV
server and an SGI UV SMN.

Procedure 4-4 To install the SGI Foundation Software

1. Log into the SGI UV server or the SGI UV SMN as the root user.

The SGI Foundation Software installation procedure is the same for both the SGI
UV server and the SGI UV SMN.

2. On the login page, complete the following steps:

• Select Not Listed?.

• In the Username field, type root.

• In the Password field, type the root user’s password.

• Click Log In.

• (Conditional) Initialize the root user account.

Complete these steps only if this is the first time you are logging in as the root
user.

Complete the following steps:

– On the Welcome page, complete the following steps:

• Select your language.

• Click Next.

– On the Input Sources page, complete the following steps:

• Select the language you use.

• Click Next.

– On the Thank You screen, click Start using Red Hat Enterprise Linux
Server.

3. Access the installation software.

Complete this step in one of the following ways:
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• If a DVD drive is available, insert the SGI Foundation Software X.X CD into the
DVD drive.

For example, an SGI UV 300 includes a DVD drive. You might have attached
a DVD drive to an SGI UV 2000 or SGI UV 1000 computer system.

• On an SGI UV 2000 without a DVD drive, complete the following steps:

– In the top-most JViewer menu bar, click Media > Virtual Media Wizard ....

– Insert the operating system DVD into the DVD drive on the SMN, or if
you are at a remote console, insert the DVD into your local desktop.

– On the Virtual Media pop-up, under CD/DVD Media 1, complete the
following steps:

• Select /dev/sr0.

• Click Connect to CD/DVD.

– On the Information pop-up, click OK.

– On the Virtual Media pop-up, click Close.

• On an SGI UV 1000 without a DVD drive, complete the following steps:

– Insert the operating system DVD into the DVD drive on the SMN, or if
you are at a remote console, insert the DVD into your local desktop.

– In the JViewer main menu, select Device > Redirect CDROM.

– On the CD-ROM Selection pop-up, select a drive.

For example, select /dev/scd0.

– Click OK.

4. Click Applications > System Tools > Terminal to open a terminal window.

5. Type the following command to create an installation directory for the files from
the CD:

# mkdir -p /opt/sgi/Factory-Install/sgi-foundation-2.12/

6. Type the following command to create a temporary mount directory:

# mkdir /var/sfs2.12
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7. Type the following command to mount the CD in read-only mode (-r), using a
loop device:

# mount -t iso9660 -ro loop /dev/cdrom /var/sfs2.12

8. Type the following command to copy the files from the temporary mount
directory to the installation directory:

# rsync -avHx /var/sfs2.12/ /opt/sgi/Factory-Install/sgi-foundation-2.12/

9. Type the following command to unmount the CD from the temporary directory:

# umount /var/sfs2.12

10. Type the following command to remove the temporary mount directory:

# rmdir /var/sfs2.12

11. Use a text editor to create file
/etc/yum.repos.d/foundation2.12-local.repo with the following
contents:

########################################

[foundation2.12-repo]

name=SGI Foundation Software 2.12 - $basearch

baseurl=file:///opt/sgi/Factory-Install/sgi-foundation-2.12/RPMS
enabled=1

gpgcheck=1

gpgkey=file:///opt/sgi/Factory-Install/sgi-foundation-2.12/RPM-GPG-KEY-sgi

########################################

12. Type the following command to retrieve the list of software that you can install:

# yum grouplist | grep SGI

13. Type the following command to install the SGI Foundation Software group:

# yum groupinstall "SGI Foundation Software"

14. Type y at the following prompt to confirm the download size:

Is this ok [y/N]

15. Type y at the following prompt to accept the GPG license key:

Is this ok [y/N]
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16. Open a terminal window on the booted system.

17. In the terminal window, type the following command to reboot the system:

# reboot

18. After the system reaches the EFI shell, in the RMC or CMC command window,
type the following command to reset the full system:

# power reset
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Chapter 5

Installing a SLES 11 Platform

This chapter includes the following topics:

• "About Installing the SLES Operating System on an SGI UV System or an SGI UV
SMN" on page 65

• "Installing the SLES Operating System Software on an SGI UV Server or an SGI
UV SMN" on page 66

• "Installing the SGI Foundation Software on a SLES Platform SGI UV Server or a
SLES Platform SMN" on page 81

• "Installing the SMN Software on a SLES Platform SMN (SGI UV 2000, SGI UV
1000, and SGI UV 100 Platforms Only)" on page 82

About Installing the SLES Operating System on an SGI UV System or an
SGI UV SMN

This chapter explains how to install the following software on an SGI UV server and
on an SGI UV system management node (SMN):

• The SLES operating system. The operating system installation instructions are
nearly identical for the SGI UV server and the SMN. The instructions note
differences where necessary.

• The SGI Foundation Software. The SGI Foundation Software installation
instructions are nearly identical for the SGI UV server and the SMN. The
instructions note differences where necessary.

• The SMN software. This is an SMN-specific package. SGI UV 2000 systems and
SGI UV 1000 systems can have an SMN. The SGI UV 300 systems do not have
SMNs.

Note: SGI supports only the SLES 11 operating system on the SMN. If your SGI
UV system includes an SMN, use the procedures in this chapter to install SLES 11
as the operating system on the SMN and to install the latest SGI Foundation
Software and SMN software.
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The following additional documentation might be useful to you during this
installation process:

• The SLES 11 Installation Quick Start and the SLES 11 Deployment Guide. These
guides are available at the following location:

https://www.suse.com/documentation/sles11/

• The SGI Foundation Software 2.X release notes file. After you log into
Supportfolio, you can retrieve the release notes from the following location:

https://support.sgi.com/content_request/194480/index.html

• The SMN software release notes file. After you log into Supportfolio, you can
retrieve the release notes from the following location:

https://support.sgi.com/content_request/738299/index.html

Installing the SLES Operating System Software on an SGI UV Server or an
SGI UV SMN

The following procedures explain how to install the SLES operating system software:

• "Initiating the Installation" on page 67

• "(Conditional) Specifying Disk Partitions for an SGI UV SMN" on page 68

• "Specifying Disk Partitions for an SGI UV Server" on page 72

• "Specifying the Network and Miscellaneous Settings" on page 76

• "Completing the SLES Installation" on page 80

Note: The mouse unit’s behavior can be unpredictable during the following
procedures:

• "Initiating the Installation" on page 67
• "Specifying Disk Partitions for an SGI UV Server" on page 72
• "(Conditional) Specifying Disk Partitions for an SGI UV SMN" on page 68

After the first boot, the mouse unit behaves as expected.
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Initiating the Installation

The following procedure explains how to begin the installation.

Procedure 5-1 To begin the installation

1. Make sure you prepared for the installation and selected Installation on the boot
loader screen.

For more information, see the following:

"Gathering Installation Materials and Information" on page 7

2. On the Welcome page, complete the following steps:

• Select your language.

• Select your keyboard layout.

• Click I agree to the license terms.

• Click Next.

3. On the Media Check page, complete the following steps:

• (Conditional) Select Start Check.

Select this option if you want to troubleshoot a failed installation. If a
previous installation failed, you can check this option, install the operating
system software again, and observe the messages that the installer issues. It is
possible that media problems prevented your previous installation from
completing correctly.

• Click Next.

If this is your first installation session, you can click Next safely.

4. On the System Probing ... screen, monitor the progress.

5. On the Installation Mode screen, accept the default of New Installation, and
click Next.

6. On the Clock and Time Zone screen, complete the following steps:

• Select your region.

• Select your time zone.
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• Check the box next to Hardware Clock Set To UTC.

• Click Next.

7. On the Server Base Scenario screen, accept the default of Physical Machine, and
click Next.

8. Proceed to one of the following:

• To configure disk partitions on an SMN, complete the following procedure:

"(Conditional) Specifying Disk Partitions for an SGI UV SMN" on page 68

• To configure disk partitions on an SGI UV server, complete the following
procedure:

"Specifying Disk Partitions for an SGI UV Server" on page 72

(Conditional) Specifying Disk Partitions for an SGI UV SMN

Perform the procedure in this topic if you need to configure an SGI UV SMN.

This topic includes information about disk partitioning for SGI UV system SMNs.
The procedure in this topic explains how to configure the disk partitions and monitor
a reboot.

For the SMN, your goal is to configure the disks according to Table 5-1 on page 68.

Table 5-1 Disk Partitions for an SGI UV SMN

Size Mount Point File System

200 MB /boot Ext3

250 GB (256,000 MB) / XFS

8192 MB swap swap

rest of disk /data1 XFS

The following procedure explains how to specify the disk partitions.

Procedure 5-2 To configure the disk partitions

1. On the Installation Settings screen, click the Partitioning link.
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2. On the Preparing Hard Disk screen, click Custom Partitioning (for experts), and
click Next.

3. On the Expert Partitioner screen, complete the following steps to clean the disk:

• Expand Hard Disks.

• Select the disk you want to use.

For example, select sda.

• Click the Expert ... button on the lower right part of the screen, and select
Create New Partition Table.

• On the YaST2 pop-up with the message Really create a new partition table ...,
click Yes.

• Proceed to the next step after you have deleted all existing partitions.

4. On the Expert Partitioner screen, complete the following steps:

• Expand Hard Disks.

• Select the hard disks you want to use.

• Click Add.

5. Complete the following steps on the Add Partition on /dev/disk screen to
configure the boot partition:

• Under New Partition Type, select Primary Partition, and click Next.

• Under New Partition Size, click Custom Size.

• Specify 200 MB in the Size field.

• Click Next.

• Under Formatting Options, select Format partition.

• Under File system, use the pull-down menu to select Ext3.

• Under Mounting Options, select Mount Partition.

• Under Mount point, use the pull-down menu to select /boot.

• Select Finish.
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6. On the Expert Partitioner screen, click Add.

7. On the Add Partition on /dev/disk screen, select Primary Partition, and click Next.

8. Complete the following steps on the Add Partition on /dev/disk screen to
configure the root partition:

• Under New Partition Size, click Custom Size.

• Specify 250 GB in the Size field.

• Click Next.

• Under Formatting Options, select Format partition.

• Under File system, use the pull-down menu to select XFS.

• Under Mounting Options, select Mount Partition.

• Under Mount point, use the pull-down menu to select /.

• Select Finish.

9. On the Expert Partitioner screen, click Add.

10. On the Add Partition on /dev/disk screen, select Primary Partition, and click Next.

11. Complete the following steps on the Add Partition on /dev/disk screen to
configure the swap partition:

• Under New Partition Size, click Custom Size.

• Specify 8 GB in the Size field.

• Click Next.

• Under Formatting Options, select Format partition.

• Under File system, use the pull-down menu to select Swap.

• Under Mounting Options, select Mount Partition.

• Under Mount point, use the pull-down menu to select swap.

• Select Finish.

12. On the Expert Partitioner screen, click Add.

13. On the Add Partition on /dev/disk screen, select Primary Partition, and click Next.
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14. Complete the following steps on the Add Partition on /dev/disk screen to
configure the data partition:

• Under New Partition Size, click Maximum Size.

• Click Next.

• Under Formatting Options, select Format partition.

• Under File system, use the pull-down menu to select XFS.

• Under Mounting Options, select Mount Partition.

• Under Mount point, type /data1.

• Select Finish.

15. On the Expert Partitioner screen, examine the disk partitions in the Partitions tab.

If the partitions match those in Table 5-2 on page 72, click Accept.

If the partitions are incorrect, correct the partition specifications.

16. On the Installation Settings screen, complete the following steps:

• Click the Expert tab near the top of the page.

• Scroll down to Kdump, and click the Kdump link.

• In the Kdump Memory box, type one of the following values:

– For the SGI UV server, type 512.

– For the SMN, type 256.

• Click OK.

17. On the Installation Settings screen, click Install.

18. On the Confirm Package License: agfa-fonts pop-up, click I Agree.

19. On the Confirm Installation pop-up, click Install.

20. Monitor the installation and be prepared to remove the installation software
media before the boot.
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The installation itself can take several minutes. At the end of the installation, the
system boots. The installation software notifies you of this boot. If you can,
remove the installation DVD before the system boots, as follows:

• If you are performing the installation at the console, remove the DVD.

• If you are performing the installation remotely, complete the following steps:

– Click Media > Virtual Media Wizard.

– Under CD/DVD Media1, select Disconnect CD/DVD.

– Click Close.

If you fail to remove the installation DVD before the final boot, the machine boots
from the DVD. In this case, remove the DVD after the boot; press
CTRL—ALT—DEL to boot the machine again; and allow the machine to boot from
the hard disk to finish the installation.

21. Proceed to the following:

"Specifying the Network and Miscellaneous Settings" on page 76

Specifying Disk Partitions for an SGI UV Server

Perform the procedure in this topic to configure the partitions for an SGI UV server.

This topic includes information about disk partitioning for SGI UV system servers.
The procedure in this topic explains how to configure the disk partitions and monitor
a reboot.

For the SGI UV server, your goal is to configure the disks according to Table 5-2.

Table 5-2 Disk Partitions for an SGI UV Server

Size Mount Point File System

500 MB /boot/efi FAT

250 GB / Ext3

8 GB swap Swap

rest of disk /data1 Ext3
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The following procedure explains how to specify the disk partitions.

Procedure 5-3 To configure the disk partitions

1. On the Installation Settings screen, click the Partitioning link.

2. On the Preparing Hard Disk screen, click Custom Partitioning (for experts), and
click Next.

3. On the Expert Partitioner screen, complete the following steps to clean the disk:

• Expand Hard Disks.

• Select the disk you want to use.

For example, select sda.

• Click the Expert ... button on the lower right part of the screen, and select
Create New Partition Table.

• On the YaST2 pop-up with the message Really create a new partition table ...,
click Yes.

• Proceed to the next step after you have deleted all existing partitions.

4. On the Expert Partitioner screen, complete the following steps:

• Expand Hard Disks.

• Select the hard disks you want to use.

• Click Add.

5. Complete the following steps on the Add Partition on /dev/disk screen to
configure the boot partition:

• Under New Partition Size, click Custom Size.

• Type 500 MB in the Size field.

• Click Next.

• Under Formatting Options, select Format partition.

• Under File system, use the pull-down menu to select FAT.

• Under Mounting Options, select Mount Partition.

• Under Mount point, use the pull-down menu to select /boot/efi.
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• Select Finish.

6. On the Expert Partitioner screen, click Add.

7. Complete the following steps on the Add Partition on /dev/disk screen to
configure the root partition:

• Under New Partition Size, click Custom Size.

• Type 250 GB in the Size field.

• Click Next.

• Under Formatting Options, select Format partition.

• Under File system, use the pull-down menu to select Ext3.

• Under Mounting Options, select Mount Partition.

• Under Mount point, use the pull-down menu to select /.

• Select Finish.

8. On the Expert Partitioner screen, click Add.

9. Complete the following steps on Add Partition on /dev/disk screen to configure
the swap partition:

• Under New Partition Size, click Custom Size.

• Specify 8 GB in the Size field.

• Click Next.

• Under Formatting Options, select Format partition.

• Under File system, use the pull-down menu to select Swap.

• Under Mounting Options, select Mount Partition.

• Under Mount point, use the pull-down menu to select swap.

• Select Finish.

10. On the Expert Partitioner screen, click Add.

11. Complete the following steps on the Add Partition on /dev/disk screen to
configure the data partition:
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• Under New Partition Size, click Maximum Size.

• Click Next.

• Under Formatting Options, select Format partition.

• Under File system, use the pull-down menu to select Ext3.

• Under Mounting Options, select Mount Partition.

• Under Mount point, type /data1.

• Select Finish.

12. On the Expert Partitioner screen, in the Partitions tab, examine the disk partitions.

If the partitions match those in Table 5-2 on page 72, click Accept.

If the partitions are incorrect, correct the partition specifications.

13. On the Installation Settings screen, click Install.

14. On the Confirm Package License: agfa-fonts pop-up, click I Agree.

15. On the Confirm Installation pop-up, click Install.

16. Monitor the installation and be prepared to remove the installation software
media before the boot.

The installation itself can take several minutes. At the end of the installation, the
system boots. The installation software notifies you of this boot. If you can,
remove the installation DVD before the system boots, as follows:

• If you are performing the installation at the console, remove the DVD.

• If you are performing the installation remotely, complete the following steps:

– Click Media > Virtual Media Wizard.

– Under CD/DVD Media1, select Disconnect CD/DVD.

– Click Close.

If you fail to remove the installation DVD before the final boot, the machine boots
from the DVD. In this case, remove the DVD after the boot; press
CTRL—ALT—DEL to boot the machine again; and allow the machine to boot from
the hard disk to finish the installation.
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17. Proceed to the following:

"Specifying the Network and Miscellaneous Settings" on page 76

Specifying the Network and Miscellaneous Settings

The following procedure explains how to specify the hostname, networking
information, and other miscellaneous settings.

Procedure 5-4 To specify the hostname, networking, and miscellaneous settings

1. On the Password for the System Administrator “root” screen, complete the
following steps:

• In the Password for root User field, type the root user’s password.

• In the Confirm password field, retype the root user’s password.

• Type a few characters in the Test Keyboard Layout field. For example, if you
specified a language that includes non-English characters and you include
these characters in passwords, type these characters into this field. This is a
plain text field, and you can assure yourself that the operating system
recognizes these characters when you type them.

• Click Next.

2. On the Hostname and Domain Name screen, complete the following steps:

• Type the hostname.

• Type the domain name.

• Verify that Change Hostname via DHCP is set correctly.

To assign a static IP address, clear the checkbox to the left of the Change
Hostname via DHCP label. A later step saves the hostname to the
/etc/hosts file. Consult your network administrator if you have questions
regarding the use of DHCP.
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Note: This procedure explains how to configure a static address on a network
card. This is an example. If you want a different network configuration, for
example if you want to configure DHCP, ensure that the checkbox in this step
is checked before you click Next. You can use this procedure as a guide and
consult the SLES documentation for more specific steps.

• Select Next.

3. On the Network Configuration screen, proceed as follows:

• For an SGI UV server configuration, complete the following steps:

– Click the Network Interfaces link.

– Proceed to the next step in this procedure, which is as follows:

Procedure 5-4, step 4 on page 77

• For an SGI UV SMN, complete the following steps:

– Click Next.

– Jump to the following step in this procedure:

Procedure 5-4, step 9 on page 79

4. On the Network Settings screen, highlight the network card you want to
configure, and click Edit.

5. On the Network Card Setup screen, specify dynamic or static addressing, as
follows:

007–5948–006 77



5: Installing a SLES 11 Platform

To specify dynamic addressing: To specify static addressing:

1. Select the type of dynamic addressing
that you want.

1. Verify that eth0 appears in the
Configuration Name field, and click
Statically assigned IP Address.

2. Click Next to accept the default of
DHCP.

2. Configure the first NIC (eth0) for
your house (public) network.
On the Address tab, specify the
following:

• The IP Address
• The Subnet Mask
• The Hostname

3. Click Next.

6. On the Network Settings screen, complete the following steps:

• Click the Hostname/DNS tab.

• On the Hostname/DNS tab, specify the following:

– The IP address for Name Server 1.

– (Optional) The IP address for Name Server 2.

– (Optional) The IP address for Name Server 2.

– (Optional) In the Domain Search field, add additional domains.

• Click the Routing tab.

• On the Routing tab, type the Default Gateway, and click OK.

7. (Optional) Examine the Network Configuration screen, and supply additional
network information as required by your site.

For example, you might want to change the following settings:

• Firewall settings. If you enable a firewall, make sure to enable the firewall
only for the public NIC (eth0). The firewall is enabled by default.

• VNC Remote Administration. This setting enables remote administration and
is disabled by default.
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• By default, the SSH port is closed, and the menu displays SSH port is
blocked (open). Click open to open this port.

8. Click Next to advance from the Network Configuration screen.

Wait for the installer to save the network configuration.

9. On the Test Internet Connection screen, click Next.

Wait for the internet connection test to complete.

10. On the Running Internet Connection test screen, click Next.

11. On the Novell Customer Center Configuration screen, complete the following
steps:

• Select Configure Now (Recommended).

• Verify that each of the following defaults under Include for Convenience are
selected:

– Hardware Profile

– Optional Information

– Regularly Synchronize With the Customer Center

• Click Next.

For more information about how to register with Novell, see the following
website:

www.novell.com

12. On the YaST2 Manual Interaction Required pop-up, click Continue.

13. On the Novell Customer Center System Registration screen, complete the fields,
and click Submit.

14. On the Novell Customer Center Configuration screen, click Next.

15. On the Network Services Configuration screen, click Next.

16. Proceed to the following:

"Completing the SLES Installation" on page 80
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Completing the SLES Installation

The following procedure explains how to complete the SLES installation.

Procedure 5-5 To complete the SLES installation

1. On the User Authentication Method screen, select one of the authentication
methods, and click Next.

2. On the New Local User screen, create at least one non-root user.

Complete the following steps:

• Complete the following fields:

– User’s Full Name

– Username

– Password

– Confirm Password

• (Optional) Click User Management to specify another non-root user.

• Click Next.

3. On the Release Notes screen, click Next.

4. (Conditional) Let the Yast2 popup time out.

Complete this step if this installation is for the SMN and if the system issues a
popup here.

5. On the Hardware Configuration screen, click Next.

6. On the Installation Completed screen, click Finish.

7. Proceed to the following:

"Installing the SGI Foundation Software on a SLES Platform SGI UV Server or a
SLES Platform SMN" on page 81
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Installing the SGI Foundation Software on a SLES Platform SGI UV Server
or a SLES Platform SMN

The following procedure explains how to install the SGI Foundation Software on an
SMN or on an SGI UV server that hosts the SLES operating system.

Procedure 5-6 To install the SGI Foundation Software on a SLES platform from the
direct-attached console

1. Insert the CD labeled SGI Foundation Software X.X into the DVD drive on the SMN.

2. Log into the computer as the root user.

3. Click Computer > YaST to start the YaST interface.

4. Click Software > Software Repositories to start the SLES repository manager.

5. On the Configured Software Repositories screen, click Add.

6. On the Media Type screen, select DVD, and click Next.

7. On the YaST pop-up, click Continue.

8. (Conditional) On the Import Untrusted GnuPG Key, click Import.

Perform this step if this is the first time through this process and you need to
confirm the security of the SGI digital key.

9. On the Configured Software Repositories screen, click OK.

10. On the YaST Control Center screen, click Software Management.

11. Select View > Patterns.

12. Scroll down to SGI Foundation.

13. Check the box to the left of SGI Foundation Libraries, Software, and Drivers,
and click Accept.

14. On the Changed Packages pop-up, click Continue.

15. Insert CDs into the DVD drive as directed by the prompts on the Perform
Installation screen.

If necessary, click Eject on the YaST2 pop-up to open the DVD drive. In the YaST
pop-up, you might need to click Retry more than once to read a new disc. You
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can ignore the graphic representation of the file system that appears in a new
window during this step.

16. Close the YaST session.

17. Open a terminal window on the booted system.

18. In the terminal window, type the following command to reboot the system:

# reboot

19. After the system reaches the EFI shell, in the RMC or CMC command window,
type the following command to reset the full system:

# power reset

20. (Conditional) Install the SMN-specific software on the SMN.

Perform the following procedure to complete the SMN software installation:

"Installing the SMN Software on a SLES Platform SMN (SGI UV 2000, SGI UV
1000, and SGI UV 100 Platforms Only)" on page 82

The SGI UV server installation is finished at this time.

Installing the SMN Software on a SLES Platform SMN (SGI UV 2000, SGI UV
1000, and SGI UV 100 Platforms Only)

The SMN requires its own specific software, and you need to install the SMN
software on the SMN after you install the SGI Foundation Software.

The following procedure explains how to install the SMN software on a SLES
platform SMN.

Procedure 5-7 To install the SMN software on a SLES platform SMN

1. Insert the CD labeled SGI System Management Node Software X.X into the DVD
drive on the SMN.

2. Complete the following steps from "Installing the SGI Foundation Software on a
SLES Platform SGI UV Server or a SLES Platform SMN" on page 81:

• Procedure 5-6, step 2 on page 81

through
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• Procedure 5-6, step 11 on page 81

3. Scroll down to SGI SMN.

4. Check the box to the left of SGI System Management Node Libraries, Software,
and Drivers and click Accept.

5. Return to "Installing the SGI Foundation Software on a SLES Platform SGI UV
Server or a SLES Platform SMN" on page 81, and complete the following steps:

• Procedure 5-6, step 14 on page 81

through

• Procedure 5-6, step 18 on page 82

6. Log into the system as the root user.

7. Type the following command to reboot the system:

# reboot

8. Type the following command to configure the SMN software:

# smnconfig -Aa -3

9. Type the following command to reboot the system:

# reboot
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Chapter 6

Installing a SLES 12 Platform

This chapter includes the following topics:

• "About Installing the SLES Operating System and the SGI Foundation Software
(SFS) on an SGI UV System" on page 85

• "Installing the SLES Operating System Software on an SGI UV Server" on page 86

• "Installing the SGI Foundation Software on a SLES 12-based SGI UV Server" on
page 94

About Installing the SLES Operating System and the SGI Foundation
Software (SFS) on an SGI UV System

This chapter explains how to install the following software on an SGI UV server:

• The SLES 12 operating system.

• The SGI Foundation Software.

Note: SGI UV 2000 systems and SGI UV 1000 systems can have an SMN. The SGI UV
300 systems do not have SMNs.

SGI supports either SLES 12 or SLES 11 on the server, but SGI supports only SLES 11
on the SMN.

For information about how to install SLES 11 operating system and the SMN software
on an SGI UV SMN, see the following:

Chapter 5, "Installing a SLES 11 Platform" on page 65

The following additional documentation might be useful to you during this
installation process:

• The Installation Quick Start and the Deployment Guide. These guides are available at
the following location:

https://www.suse.com/documentation/sles–12/
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• The SGI Foundation Software 2.X release notes file. After you log into
Supportfolio, you can retrieve the release notes from the following location:

https://support.sgi.com/content_request/194480/index.html

Note: If your SGI UV system includes a system management node (SMN), be aware
that SGI does not support the SLES 12 operating system on the SMN. SGI supports
only the SLES 11 operating system on the SMN, but SGI continues to update the SGI
Foundation Software and the SMN software for use on SLES 11–based SMNs. To
install the system software on an SMN, use the procedures in the following chapter to
install the SLES 11 operating system, the latest SGI Foundation Software, and the
latest SMN software:

Chapter 5, "Installing a SLES 11 Platform" on page 65

Installing the SLES Operating System Software on an SGI UV Server
The following procedures explain how to install the SLES operating system software:

• "Initiating the Installation" on page 86

• "Specifying Disk Partitions for an SGI UV Server" on page 87

• "Specifying the Network and Miscellaneous Settings" on page 92

Initiating the Installation

The following procedure explains how to begin the installation.

Procedure 6-1 To begin the installation

1. Make sure you have performed the preliminary procedures and satisfied all
prerequisittes.

For more information, see the following:

"Gathering Installation Materials and Information" on page 7

2. On the boot loader screen, select Installation.

3. On the Language, Keyboard and License Agreement page, complete the
following steps:
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• Use the pull-down menu to select your language.

• Use the pull-down menu to select your keyboard layout.

• Check I Agree to the License Terms.

• Click Next.

4. On the System Probing ... screen, monitor the progress.

5. On the Registration screen, complete the following steps:

• Provide your site credentials.

• Click Next.

6. On the Add On Product screen, click Next.

7. On the Suggested Partitioning screen, complete the following steps:

• Click Expert Partitioner.

• Click Next.

8. Proceed to the following:

"Specifying Disk Partitions for an SGI UV Server" on page 87

Specifying Disk Partitions for an SGI UV Server

Perform the procedure in this topic to configure the partitions for an SGI UV server.

This topic includes information about disk partitioning for SGI UV system servers.
The procedure in this topic explains how to configure the disk partitions and monitor
a reboot.

For the SGI UV server, your goal is to configure the disks according to Table 6-1.

Table 6-1 Disk Partitions for an SGI UV Server

Size Mount Point File System

512 MB /boot/efi FAT16

250 GB (256,000 MB) / XFS
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Size Mount Point File System

8 GB (8,192 MB) swap Swap

rest of disk /data1 XFS

The following procedure explains how to specify the disk partitions.

Procedure 6-2 To configure the disk partitions

1. On the Expert Partitioner screen, complete the following steps to clean the disk:

• Expand Hard Disks.

• Select the disk you want to use.

For example, select sda.

• On the Expert ... drop-down in the lower right part of the screen, select Create
New Partition Table.

• On the YaST2 pop-up with the message Really create a new partition table ...,
click Yes.

• Proceed to the next step after you have deleted all existing partitions.

2. On the Expert Partitioner screen, complete the following steps:

• Expand Hard Disks.

• Select the hard disks you want to use.

• Click Add.

3. Complete the following steps on the Add Partition on /dev/disk screen to
configure the boot partition:

• Under New Partition Size, click Custom Size.

• Type 512 MB in the Size field.

• Click Next.

• Under the Role list, complete the following steps:

– Select Operating System.

– Click Next.
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• Under Formatting Options, select Format partition.

• Under File system, use the pull-down menu to select FAT16.

• Under Mounting Options, select Mount Partition.

• Under Mount point, use the pull-down menu to select /boot/efi.

• Select Finish.

4. On the Expert Partitioner screen, click Add.

5. Complete the following steps on the Add Partition on /dev/disk screen to
configure the root partition:

• Under New Partition Size, click Custom Size.

• Type 250 GB in the Size field.

• Click Next.

• Under the Role list, complete the following steps:

– Select Operating System.

– Click Next.

• Under Formatting Options, select Format partition.

• Under File system, use the pull-down menu to select XFS.

• Under Mounting Options, select Mount Partition.

• Under Mount point, use the pull-down menu to select /.

• Select Finish.

6. On the Expert Partitioner screen, click Add.

7. Complete the following steps on Add Partition on /dev/disk screen to configure
the swap partition:

• Under New Partition Size, click Custom Size.

• Specify 8 GB in the Size field.

• Click Next.

• Under the Role list, complete the following steps:
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– Select Swap.

– Click Next.

• Under Formatting Options, select Format partition.

• Under File system, use the pull-down menu to select Swap.

• Under Mounting Options, select Mount Partition.

• Under Mount point, use the pull-down menu to select swap.

• Select Finish.

8. On the Expert Partitioner screen, click Add.

9. Complete the following steps on the Add Partition on /dev/disk screen to
configure the data partition:

• Under New Partition Size, click Maximum Size.

• Click Next.

• Under the Role list, complete the following steps:

– Select Data and ISV Applications.

– Click Next.

• Under Formatting Options, select Format partition.

• Under File system, use the pull-down menu to select XFS.

• Under Mounting Options, select Mount Partition.

• Under Mount point, type /data1.

• Select Finish.

10. On the Expert Partitioner screen, in the Partitions tab, examine the disk partitions.

If the partitions match those in Table 5-2 on page 72, click Accept.

If the partitions are incorrect, correct the partition specifications.

11. On the Suggested Partitioning screen, click Next.

12. On the Clock and Time Zone screen, complete the following steps:

90 007–5948–006



SGI
®

UV
TM

System Software Installation and Configuration Guide

• Select your region.

• Select your time zone.

• Check the box next to Hardware Clock Set To UTC.

• Click Next.

13. On the Create New User screen, create at least one non-root user.

Complete the following steps:

• Complete the following fields:

– User’s Full Name

– Username

– Password

– Confirm Password

• Click Next.

14. On the Password for the System Administrator “root” screen, complete the
following steps:

• In the Password for root User field, type the root user’s password.

• In the Confirm password field, retype the root user’s password.

• Type a few characters in the Test Keyboard Layout field. For example, if you
specified a language that includes non-English characters and you include
these characters in passwords, type these characters into this field. This is a
plain text field, and you can assure yourself that the operating system
recognizes these characters when you type them.

• Click Next.

15. On the Installation Settings screen, click Install.

16. On the Confirm Installation pop-up, click Install.

17. Monitor the installation and be prepared to remove the installation software
media before the boot.

007–5948–006 91



6: Installing a SLES 12 Platform

The installation itself can take several minutes. At the end of the installation, the
system boots. The installation software notifies you of this boot. If you can,
remove the installation DVD before the system boots.

If you fail to remove the installation DVD before the final boot, the machine boots
from the DVD. In this case, complete the following steps:

• Remove the DVD after the boot.

• Press CTRL—ALT—DEL to boot the machine again.

• Allow the machine to boot from the hard disk to finish the installation.

18. Proceed to the following:

"Specifying the Network and Miscellaneous Settings" on page 92

Specifying the Network and Miscellaneous Settings

The following procedure explains how to specify the hostname, networking
information, and other miscellaneous settings.

Procedure 6-3 To specify the hostname, networking, and miscellaneous settings

1. Log into the SGI UV server as the root user.

2. Click Applications > System Tools > YaST.

3. On the Administrator Settings screen, click Network Settings.

4. On the Network Configuration screen, click the Network Interfaces link.

5. On the YaST2 — Network Settings screen, highlight the network card you want
to configure, and click Edit.

6. On the Network Card Setup screen, specify dynamic or static addressing, as
follows:
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To specify dynamic addressing: To specify static addressing:

1. Select the type of dynamic addressing
that you want.

1. Verify that eth0 appears in the
Configuration Name field, and click
Statically assigned IP Address.

2. Click Next to accept the default of
DHCP.

2. Configure the first NIC (eth0) for
your house (public) network.
On the Address tab, specify the
following:

• The IP Address
• The Subnet Mask
• The Hostname

3. Click Next.

7. On the Network Settings screen, complete the following steps:

• Click the Hostname/DNS tab.

• Type the hostname.

• Type the domain name.

• Verify that Change Hostname via DHCP is set correctly.

To assign a static IP address, clear the checkbox to the left of the Change
Hostname via DHCP label. A later step saves the hostname to the
/etc/hosts file. Consult your network administrator if you have questions
regarding the use of DHCP.

Note: This procedure explains how to configure a static address on a network
card. This is an example. If you want a different network configuration, for
example if you want to configure DHCP, ensure that the checkbox in this step
is checked before you click Next. You can use this procedure as a guide and
consult the SLES documentation for more specific steps.

• On the Hostname/DNS tab, specify the following:

– The IP address for Name Server 1.
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– (Optional) The IP address for Name Server 2.

– (Optional) The IP address for Name Server 2.

– (Optional) In the Domain Search field, add additional domains.

• Click the Routing tab.

• On the Routing tab, type the Default Gateway, and click OK.

8. Proceed to the following:

"Installing the SGI Foundation Software on a SLES 12-based SGI UV Server" on
page 94

Installing the SGI Foundation Software on a SLES 12-based SGI UV Server
The following procedure explains how to install the SGI Foundation Software on an
SGI UV server that hosts the SLES operating system.

Procedure 6-4 To install the SGI Foundation Software on a SLES platform

1. Insert the CD labeled SGI Foundation Software X.X into the DVD drive on the RLC.

2. Log into the computer as the root user.

3. Click Applications > System Tools > Computer > YaST to start the YaST interface.

4. Under Software, click Software Repositories to start the SLES repository manager.

5. On the Configured Software Repositories screen, click Add.

6. On the Add On Product screen, select DVD, and click Next.

7. On the YaST pop-up, click Continue.

8. (Conditional) On the Import Untrusted GnuPG Key, click Trust.

Perform this step if this is the first time through this process and you need to
confirm the security of the SGI digital key.

9. On the Configured Software Repositories screen, click OK.

10. On the YaST Control Center screen, click Software Management.

11. Select View > Patterns.
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12. Scroll down to SGI Foundation.

13. Check the box to the left of SGI Foundation Libraries, Software, and Drivers,
and click Accept.

14. On the Changed Packages pop-up, click Continue.

15. Insert CDs into the DVD drive as directed by the prompts on the Perform
Installation screen.

If necessary, click Eject on the YaST2 pop-up to open the DVD drive. In the YaST
pop-up, you might need to click Retry more than once to read a new disc. You
can ignore the graphic representation of the file system that appears in a new
window during this step.

16. On the Installation Report screen, click Finish.

17. Close the YaST session.

18. Open a terminal window on the booted system.

19. In the terminal window, type the following command to reboot the system:

# reboot

20. After the system reaches the EFI shell, in the RMC or CMC command window,
type the following command to reset the full system:

# power reset
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Chapter 7

Additional Features

This chapter provides information about additional features. It covers the following
topics:

• "Remote Management Through the ipmitool Command (SGI UV 300 Systems
Only)" on page 97

• "Superpages" on page 98

• "Configuring Security-Enhanced Linux (SELinux) (RHEL Platforms Only)" on page
100

Remote Management Through the ipmitool Command (SGI UV 300
Systems Only)

From a remote console, you can use ipmitool commands to perform typical system
operations.

In order for the ipmitool command to work, the remote console must be on the
same local network as the SGI UV 300 system. The following shows the ipmitool
command format:

ipmitool -I lanplus -H hostname -U ADMIN -P password command

The arguments to the command’s parameters are as follows:

Parameter Meaning

hostname The hostname of the SGI UV 300 system on your network.

password The system’s administrative password. The factory-shipped, default
password is ADMIN.

command One of the ipmitool commands.

There many IPMI commands. The commands that SGI supports for SGI
UV 300 remote management are as follows:

• power off

• power reset
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• power on

Superpages
Superpages is part of the SGI Performance Suite. The following topics describe
superpages:

• "About Superpages" on page 98

• "Examples" on page 98

• "Saving Your Superpage Configuration" on page 100

About Superpages

Superpages allow you to map large areas of reserved memory into your application.
libsuperpages is a library for allocating and mapping SGI UV superpages. For
more information, see the libsuperpages(3) man page. If your SGI UV system is
partitioned, you can define superpages within a partition.

Superpages are defined in an EFI firmware variable as a kernel boot option. When
you enable superpages, you need to boot the system and then the SGI UV reserves
the amount of specified memory to be used via superpages. The reserved memory is
not available to the operating system for its regular activities. The SGI UV BIOS
passes superpage addresses to the superpages driver as an Advanced Configuration
and Power Interface (ACPI) device.

The superpages command allows you to test the functionally of an SGI UV system’s
superpages. The superpages_define -w command creates superpages0, which
is an EFI variable that resides on the chassis management controller (CMC) and
defines superpages. You must be a superuser (root) to run this command. After
execution, to enable superpages, you need to reboot the system. The system BIOS
then reserves the system memory for superpages rather than providing it to the
operating system. For a usage statement, enter superpages -h.

Examples

The following examples show the superpages_define command:
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• Example 1. The superpages_define command’s -L option displays valid
superpage sizes, as follows:

uv-sys:~ # superpages_define -L

Valid superpage sizes:

0x100000000 4G (4294967296)

0x400000000 16G (17179869184)
0x1000000000 64G (68719476736)

0x4000000000 256G (274877906944)

0x10000000000 1T (1099511627776)

• Example 2. The superpages_define -c command displays the available
memory ranges for superpage allocation, as follows:

uv-sys:~ # superpages_define -c

available memory ranges for superpage allocation:

0x100000000-0x87fffffff 0x780000000 30G

0x1000000000-0x17feffffff 0x7ff000000 31G
available memory: 61G (63472M)

• Example 3. The following command shows the 4G areas of memory that can be
used as superpages:

uv-sys:~ # superpages_define -p 4G

in /etc/superpages.conf format:

# for pagesize: 0x100000000 4G

size_4G 4G #node0 0x100000000:3 #node1 0x400000000:4 #node2 0x1000000000:4 #node 3 0x1400000000:3

# 14 4G superpages

• Example 4. The following command shows the 4G areas of memory that can be
used as superpages, but it limits such areas to two per node:

uv-sys:~ # superpages_define -p 4G -n 2

in /etc/superpages.conf format:

# for pagesize: 0x100000000 4G

size_4G 4G #node0 0x100000000:2 #node1 0x400000000:2 #node2 0x1000000000:2 #node3 0x1400000000:2

# 8 4G superpages

• Example 5. After you are satisfied with your memory selection, type commands
similar to the following to define superpages:
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uv-sys:~ # superpages_define -p 4G -n 2 > /etc/superpages.conf
uv-sys:~ # superpages_define -w

When you reboot your SGI UV system, the specified areas are superpages.

Saving Your Superpage Configuration

If you reconfigure your system’s superpages, the new configuration goes into effect
after you reboot the system. To use the same configuration and avoid a reboot, you
can save superpage configuration information to an EFI variable. The SGI UV system
stores the EFI variable on the CMC, and you can use the efiv command to restore
the configuration. The superpages0 variable contains the addresses and lengths of
all the superpages.

You can use the efiv command as follows:

• To display the superpage configuration, type the following command:

CMC> efiv -p part_num -l | grep superpage

For part_num, specify the partition number. For example, specify 0 on an
unpartitioned system.

• To save the superpage configuration, type the following command:

CMC> efiv -p -s superpage0 2> /dev/null > superpage0

• To restore a superpage configuration, type the following command:

CMC> efiv -c superpage0

• To delete a superpage configuration, type the following command:

CMC> efiv -p part_num -d superpage0

For part_num, specify the partition number. For example, specify 0 on an
unpartitioned system.

Configuring Security-Enhanced Linux (SELinux) (RHEL Platforms Only)
You can configure SELinux on an SGI UV computer that runs the Red Hat Enterprise
Linux (RHEL) operating system. SELinux supports Multi-Level Security (MLS) and
Multi-Category Security (MCS) modes. When you configure SELinux, you create an
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MLS-compliant or MCS-compliant environment on an SGI UV computer system, and
you enable SGI MPI programs to take full advantage of all the features that SGI
Accelerate provides on SGI UV hardware. For more information about SELinux, see
your RHEL documentation.

Note: If you are not interested in MLS or MCS, you do not need to configure
SELinux. In this case, do not perform the procedure in this topic.

The SLES operating system does not support SELinux.

To obtain help output for the sgi-selinux-configuration command, type the
command name, with no options. For example:

# sgi-selinux-configuration

sgi-selinux-configuration

Actions
-h|--help Print usage

-s|--status Return module(s) status

-i|--insert Insert policy module

-r|--remove Remove policy module

-l|--label Label policy files
-R|--restart Restart services affected by SGI policies

Select target policy modules (default is all)

-S|--services Perform operation on services

-D|--devices Perform operation on devices
--bigpage

--gru

--mmtimer

--xpmem

--procset

--arraysvcs

The following procedure explains how to configure SELinux on an SGI UV computer
system.

Procedure 7-1 To configure SELinux

1. Log in as root.
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2. Type the following commands to load the SELinux software modules from the
RHEL distribution:

# yum install policycoreutils-python

# yum install selinux-policy-mls

sgi_bigpage 1.0.0

sgi_gru 1.0.0

sgi_mmtimer 1.0.0

sgi_xpmem 1.0.0
sgi_procset 1.0.0

sgi_arraysvcs 1.0.0

3. Type the following command to ensure that the modules are loaded correctly:

# sgi-selinux-configuration -s

If the SELinux software modules are loaded correctly, the command returns a list
of the loaded modules.

If the sgi-selinux-configuration -s command returns nothing, then the
policy modules did not load correctly. Type the following command to load all
SGI policies:

# sgi-selinux-configuration -i

4. Type the following command to apply security labels to the file system for all
kernel modules and services:

# sgi-selinux-configuration -l

Note that the option to the preceding command is a lowercase L character.

5. Type the following command to restart services:

# sgi-selinux-configuration -R

6. (Conditional) Repeat the preceding steps on other partitions.

Perform the steps in this procedure again on all other partions if your SGI UV
computer is divided into partitions.

102 007–5948–006



Index

C

command
power reset, 15

console
exiting, 18, 20
setting an administrative password, 15

E

exit console, 18, 20

I

install SLES 11 on the SMN, 66
install SLES 12, 86
install software

SGI UV server, 7
installing RHEL on the SMN, 35

installing SLES, 85
installing SLES on the SMN, 65

N

navigate the device manager, 17, 20

P

power reset command, 15

S

setting an administrative password on the
console, 15

SGI UV server installation, 7
system management node (SMN), 66

007–5948–006 103


	New Features
	Table of Contents
	About This Guide
	Related Publications
	Obtaining Publications
	Conventions
	Reader Comments

	1. Introduction
	About Installing the Operating System Software, SGI Foundation Suite, and Optional Features
	About Partitioned SGI UV Systems
	About Installing the SGI Performance Suite

	2. Installing the SGI UV System Software
	About Installing SGI UV System Software
	Gathering Installation Materials and Information
	(Optional) Setting or Changing an Administrative Password on the Console
	Setting or Changing the Password on an SGI UV 300 System
	Setting or Changing the Password on an SGI UV 2000, SGI UV 1000, or SGI UV 100 System

	(Conditional) Installing the System Software on the SMN
	Installing the System Software on the Server
	Installing the SGI UV System Software on an SGI UV 300 Server
	Installing the SGI UV System Software on an SGI UV 2000, SGI UV 1000, or SGI UV 100 Server With an SMN
	Installing the SGI UV System Software on an SGI UV 2000, SGI UV 1000, or SGI UV 100 Server Without an SMN


	3. Installing a Red Hat Enterprise Linux (RHEL) 6 Platform
	About Installing the RHEL Operating System on an SGI UV System
	Installing the RHEL Operating System Software on an SGI UV Server or an SGI UV SMN
	Initiating the Installation
	Specifying the Network
	(Conditional) Specifying Disk Partitions for an SGI UV SMN
	Specifying Disk Partitions for an SGI UV Server
	Completing the RHEL Installation

	Installing the SGI Foundation Software on a RHEL Platform SGI UV Server or a RHEL Platform SMN
	(Conditional) Installing the SMN Software on a RHEL Platform SMN (SGI UV 2000, SGI UV 1000, and SGI UV 100 Platforms Only)

	4. Installing a Red Hat Enterprise Linux (RHEL) 7 Platform
	About Installing the RHEL Operating System on an SGI UV System
	Installing the RHEL Operating System Software on an SGI UV Server
	Initiating the Installation and Partitioning the Disk
	Configuring the Network and Rebooting
	Completing the Installation

	Installing the SGI Foundation Software on a RHEL 7-based SGI UV Server

	5. Installing a SLES 11 Platform
	About Installing the SLES Operating System on an SGI UV System or an SGI UV SMN
	Installing the SLES Operating System Software on an SGI UV Server or an SGI UV SMN
	Initiating the Installation
	(Conditional) Specifying Disk Partitions for an SGI UV SMN
	Specifying Disk Partitions for an SGI UV Server
	Specifying the Network and Miscellaneous Settings
	Completing the SLES Installation

	Installing the SGI Foundation Software on a SLES Platform SGI UV Server or a SLES Platform SMN
	Installing the SMN Software on a SLES Platform SMN (SGI UV 2000, SGI UV 1000, and SGI UV 100 Platforms Only)

	6. Installing a SLES 12 Platform
	About Installing the SLES Operating System and the SGI Foundation Software (SFS) on an SGI UV System
	Installing the SLES Operating System Software on an SGI UV Server
	Initiating the Installation
	Specifying Disk Partitions for an SGI UV Server
	Specifying the Network and Miscellaneous Settings

	Installing the SGI Foundation Software on a SLES 12-based SGI UV Server

	7. Additional Features
	Remote Management Through the ipmitool Command (SGI UV 300 Systems Only)
	Superpages
	About Superpages
	List of Examples

	Saving Your Superpage Configuration

	Configuring Security-Enhanced Linux (SELinux) (RHEL Platforms Only)

	Index

